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1 Introduction

Plant Wizard is an application designed to help coordinate the many administration

processes involved in the successful implementation of a tree planting project. These

include the business processes of seedling foresters, nurseries and planting contractors. By

having one system for all the main players involved in planning and implementing a tree

planting project, there can be another level of benefit achieved from sharing data between

all users.

Some of the features of Plant Wizard include:

· Importing seed to create sowing plans

· Forecasting seedling needs into the future

· Tracking seedling inventories

· Allocating seedling inventories to planned plantations

· Instantly identifying seedling surpluses and shortages

· Electronically sharing planting prescriptions and schedules with other users

· Syncing all seedling data and deliveries with JRP SSMS (Seed and Seedling

Management System)

· Tracking individual planters production on each plantation

· Balancing crew production against deliveries

· Developing detailed payroll information

· Tracking miscellaneous payroll items and/or deductions for individual planters
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2 What's New and Notable

Project

· Seedlings Tab:

· You can copy the "Allocated to Sites" values into the "Amount Assigned" column

quickly by using the Assign all from Allocated button.

· "Amount Assigned" is editable offline and will update the server when

reconnected.

Payroll

· Payroll users now get Planting Schedule permissions by default on projects they are

linked to. This can be edited.

· The Payroll Detail report now includes an option to email individual planters their

payroll details (email addresses must be entered for each planter).

Seeds

· BEC Variants and Collection BEC have been added to the seed properties and the

Display Options. The BEC Variants field contains all the possible BEC Variants that

the seedlot is suitable to be planted in. This is used for determining seed and

seedling suitability using the climate-based seed transfer (CBST) system. Collection

BEC refers to the BEC Variant location where the seed was collected.

· Importing seed from Excel requires two SPAR .csv files: the SeedlotExtractReport

and the SeedlotExtractForCbstAreaOfUseReport.

· When importing seed from a SPAR file or downloading from SSMS, the Collection

BEC and BEC Variants fields are populated. The new Genetic Worth codes are

imported as well.

Sites

· BEC Variant has been added as a site property. This is to be populated with the

dominant BGC Zone, Subzone, and Variant and is used for determining seed and

seedling suitability using the climate-based seed transfer (CBST) system.

· When importing sites from Excel, the site BEC Variant field is populated.

· The site BEC Variant is available as a Display Option.
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· Planted Tab - Adding new planting records now shows shaded columns for Tallied

amounts by seedling for reference for Payroll users only.

Planting Tab

· Payroll users can now reference the tallied amounts right in the Planting Tab grid

view by selecting "Show Tallies" in the Display Options. Seedlings claimed by

payroll users are now included in the auto allocation window when balancing

against project assigned amounts.

· Added an option to “Show surplus seedling available on SSMS” if Plant Wizard is

connected to the Internet. Any seedlings marked as surplus that match the year and

season of the projects you have loaded (match on Year/Season, Alt Year/Alt Season,

or Override Year/Override Season).

· Climate-based seed transfer (CBST) suitability has been added. Using the "BEC

Variant" suitability criteria, all other suitability criteria are ignored. Plant Wizard uses

the list of BEC Variants for the seedlots and marks the seedlings suitable on sites

that have a matching BEC Variant.

· BEC Variants for sites and seedlings have been added to the Display Options.

Sowing Tab

· Climate-based seed transfer (CBST) suitability has been added. Using the "BEC

Variant" suitability criteria, all other suitability criteria are ignored. Plant Wizard uses

the list of BEC Variants for the seedlots and marks the seed suitable on sites that

have a matching BEC Variant.

· BEC Variants for site and seed have been added to the Display Options.

Balance Tab

· Users can now balance against Shipped seedlings only, or Shipped & Planned.
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3 Getting Started

1. Creating your Plant Wizard projects.

2. Sending your Plant Wizard projects to the SSMS Server to share data with other users

and/or your mobile device for data collection in the field.

To get started with Plant Wizard, review the minimum system requirements, and install or

upgrade on the desktop and/or devices as needed.

Once installed, you are ready to create and share projects, or access existing projects. Sync

the desktop and devices to send and receive projects to and from mobile devices and other

users.

Setup

ØMinimum System Requirements

ØDesktop Installation and Activation

ØDevice Installation

ØDesktop Upgrade

ØDevice Upgrade

Basics

Ø Login

Ø Syncing

Ø Code Lists

Ø Account Preferences

ØUser Preferences

Ø Project Details
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3.1 Minimum System Requirements

Desktop Requirements

· .NET Framework 4.6 or newer (found at www.microsoft.com/downloads)

· Intel® Pentium® processor 400 MHz minimum (1GHz recommended)

· Windows XP or newer, Windows Server 2003 or 2008

· 96MB RAM minimum (256MB RAM recommended)

· Up to 500MB hard drive space may be required

· Microsoft Excel (to run reports)

· Internet access required for syncing data with server

Mobile Requirements

· iPad or iPad Mini with iOS 9.3.5 and greater to run PW 2018.1

· Android tablet, Android phone to run PW 2020

· iPad (Generation 4 and newer), iPad Mini (Generation 2 and newer), iPhone 5 and

newer with iOS 10.3 and greater to run PW 2020

· 2GB RAM minimum

· 3G capabilities if you wish to sync in the field

3.2 Desktop Installation, Activation, and Upgrading

To install Plant Wizard, you need administrator privileges on the computer you are

installing on.

The following instructions are intended for a local single user implementation of Plant

Wizard.  

Desktop Installation and Activation

1. Ensure you have Microsoft .NET 4.6 (or newer) installed as per the minimum

system requirements (you can confirm this by looking in the list of programs

available to uninstall/repair in the Windows Control Panel).

2. Run the desktop installer from http://jrpltd.com/Support/Updates.aspx?

Product=PlantWizard and follow the installer guide through the process.

3. Once the installation process is complete, you will need to register Plant Wizard

with the licence server. You will be prompted to do this the first time you run the

application. It will offer you two choices for activation: 

a. direct activation with a licence code, or 

http://www.microsoft.com/en-ca/download/details.aspx?id=29053
http://jrpltd.com/Support/Updates.aspx?Product=PlantWizard
http://jrpltd.com/Support/Updates.aspx?Product=PlantWizard
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b. email activation where you email JRP Solutions a unique string of characters

and we send you a licence file.

**Note:  Licence activation is by computer and licenses cannot be deactivated or

transferred once they are activated.

Upgrade Plant Wizard on Desktop

· Sync the desktop prior to upgrading to ensure all data has been sent to the server.

· Run the latest desktop installer from http://jrpltd.com/Support/Updates.aspx?

Product=PlantWizard and follow the installer guide through the process.

· If you are using Plant Wizard on multiple PCs, ensure they are all upgraded

(including users you share data with).

· If you upgrade the desktop version, upgrade to the latest mobile device version

as well (if there is one).

· The desktop version can be identified in the top left corner, or by choosing Help...

About Plant Wizard.

3.3 Mobile Device Installation and Upgrading

There are 2 Plant Wizard apps available on the App Store:

· The 2018.1 app is for earlier iOS versions (prior to 10.3) and older iPad, iPad Mini

devices

· The 2020 app is for newer iOS versions (10.3 and up) and newer iPad, iPad Mini, iPhone

devices

The 2020 Plant Wizard app is also available for Android devices.

Devices

Ø iPad - Generation 1 to 3

Ø iPad - Generation 4 and newer

Ø iPad Mini - Generation 1

http://jrpltd.com/Support/Updates.aspx?Product=PlantWizard
http://jrpltd.com/Support/Updates.aspx?Product=PlantWizard
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Ø iPad Mini - Generation 2 and

newer

Ø iPhone 5 and newer

Ø Android Phone

Ø Android Tablet

3.3.1 iPad (to Gen. 3) and iPad Mini (Gen. 1)

For older iPads (generation 3 and earlier), and 1st generation iPad Minis, use the 2018.1

app.

This app works well on the older devices. Do not upgrade to the 2020 app.

Installation

1. From the device, use the App Store to find 'Plant Wizard' and install version

2018.1. You must use an iTunes account to download. The app is free to install.

2. Sync data onto the device by providing a login and password (the same one you

use to login to SSMS and the desktop).

**Note:  If you delete Plant Wizard from an iPad or iPad Mini device, you also delete

all the data. Please ensure you have synced your data successfully prior to deleting.

Upgrade

· To upgrade to version 2018.1, ensure all data is synced, then install Plant Wizard

2018.1 from the App Store.

· Each iPad must be upgraded individually.

· The iPad version can be identified in the top right corner.

3.3.2 iPad (Gen. 4+), iPad Mini (Gen. 2+), iPhone (5+)

For iPads (Generation 4 and newer), iPad Minis (Generation 2 and newer), and iPhone (5

and newer), use the 2020 app.

Newer iPads and iPad Minis can also use the 2018.1 app if preferred.
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Installation

1. From the device, use the App Store to find 'Plant Wizard' and install version 2020

or newer. You must use an iTunes account to download. The app is free to install.

2. Sync data onto the device by providing a login and password (the same one you

use to login to SSMS and the desktop).

**Note:  If you delete Plant Wizard from an iPad device, you also delete all the data.

Please ensure you have synced your data successfully prior to deleting.

Upgrade

· Version 2020 (or newer) is not an upgrade for version 2018.1, it is an completely

new stand-alone version.

· To upgrade from version 2020 to a newer version, ensure all data is synced, then

install the newest version from the App Store.

· Each iPad must be upgraded individually.

· If you upgrade the iPad version, upgrade to the latest desktop version as well (if

there is one).

· The iPad version can be identified by selecting the  menu in the top left corner.

3.3.3 Android

Installation

1. From the device, use the Google Play Store to find 'Plant Wizard'. The app is free

to install.

2. Sync data onto the device by providing a login and password (the same one you

use to login to SSMS and the desktop).

Upgrade

· Ensure all data is synced, then install newest version from the Google Play Store.

· Each device must be upgraded individually.

· If you upgrade the device version, upgrade to the latest desktop version as well

(if there is one).
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· The device version can be identified selecting the  menu in the top left corner.

3.4 Setup

Desktop Login

· When you run Plant Wizard you will be prompted for a user name and password.

This is the same user name and password you would use for the JRP Seed and

Seedling Management System (SSMS) online.

· Use the Change Region button to select "Australia" if you are a FCNSW (staff or

contractor) user. This will allow syncing with an Australian server. The Australia

plotting system for the Forest Corporation of New South Wales method will be

used automatically when logged in to the Australian server.

· Once you login, you will be connected to SSMS if you have an Internet connection

available. This allows syncing of data and live updating of certain fields. If you do

not have an Internet connection, you can still use Plant Wizard offline, but will not

be able to sync.

· The Reset Display Settings check box deletes your Plant Wizard settings file

which locally stores your remembered login, selected Display options, filters,

sorting, etc.

Sync

· To receive any projects that you may have access to on the server, use the Sync

button after logging in for the first time.

Code Lists

There are several code lists managed in Plant Wizard, all stored by account:

· Plot Error Codes - used to track errors at the plot level.

In Australia Plotting mode, the plot error codes are broken down as follows:

o Above Ground Faults

o Below Ground Faults

o Fertilizer Faults

· Cost Codes - used to track costs at the project and site levels.

· Plant Type Codes - used to track plant type options in the Edit Site Screen.
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· Fertilizer Codes - used to track fertilizer type prescribed by species at the planting

unit level.

· Site Conditions Codes - used to track weather and soil conditions at the site level.

Precip, Cloudy, Wet/Dry Soil, and Snow have default lists that can be modified,

edited, and restored.

Anyone can add new codes, however, only those users with Account access can edit

or delete these codes. Editing code lists happens live on the server.

All other pull down lists utilize data in the database to build a list. This way, users are

guided by what is already being used in the database but can also add new codes

simply by typing them in, making them available for future data entry.

Account Preferences

Users with account permissions can specify:

· Whether they prefer to record naturals at the regen level by species (which is the

default method), or at the plot level.

· To use metric or imperial weight units.

· The planting quality percent requirements, which will highlight in green any

planting quality % in the Sites Tab grid that meets or exceeds this %.  

· Custom plot type names if the default names are not adequate. Note that the first

character of the plot type names will be used as an abbreviation on the mobile

device Plots Screen, so a unique first character is recommended.

These settings are linked to your account, are updated on the SSMS server, and apply

to all account and project users.

User Preferences

Under User Preferences you can specify:

· Your initials will ensure that every record you enter is tracked with your initials

where applicable.  

· The seed label to be used in seed-related fields.

· The seedling label can be setup to include seedling-related fields. This is shown in

prescriptions, tallies, planting, deliveries, balance, on the mobile device, as well as

on reports.

· The site label is used in reports, tallies, and balance.
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These settings are linked to your login.

Project Details

Each project has its own "Plot Multiplier". You can specify this value by editing the

Details from the Projects Tab.

The Max Seedling Inventory is used for Scheduling and represents the total number

of trees that can be stored at the project location at any given time.

3.5 Navigation

Plant Wizard has a standard tool bar along the top of the screen. There are three buttons

that are visible from almost every tab. Other buttons will appear depending on which tab

you are on - these will be covered under the appropriate section in the manual.

Sync

The Sync button is available from every tab. When changes have been made on the

desktop or serve to an active project, the Sync button will be updated to include an

orange symbol  to remind you that a sync should be done. As well, you will see the

same orange symbol after the project name. When you sync, all projects that you have

access to will be listed, with the projects from the filter year selected. De-select any

projects you do not wish to sync. Projects that exist on the SSMS server but have not

been downloaded to the desktop appear with an arrow symbol. Projects that are in sync

will have a green check box, whereas any that are out of sync will show with a sync

symbol.

Filter and Sort Data

The Account and Year filters allow you to specify which projects you wish to display:

All projects that belong to that Year and Account will be listed. Projects that are

available to be downloaded to the desktop will show with a green arrow. Right-click to

download or sync and select that project for downloading. Archived projects will be



Getting Started 15

© 2012 to 2020 JRP Solutions Ltd.

shown with a green file cabinet icon beside them. You can right-click any project to

archive or unarchive it (with Account permission), regardless of whether it is downloaded

or not. You can also hide or show archived projects in the list by using the Hide/Show

Archived button in the menu.

When navigating between the Projects, Scheduling, and Shipments tabs, the same

project will be selected.

The Filter button (on the Sites tab) allows you to choose which project(s) you wish to

see. This is the same as using the filter option on the Project Name column. When

navigating between the Sites, Planting, and Sowing tabs, the same project filter will be

applied. If the project filter is reset on any of these tabs, all other filters will be removed

on the current and related tabs.

Many of the grid column and row headers have filters and sorting available.

When filtering or selecting items, use the box in the top left to select all or deselect all.

Filters used within tabs will be remembered for each account/year. If a user switches to

another account and/or year, the filters previously used on that account/year combo will

be shown.

There is a Payroll Filter button on the Payroll Tab and a Balance Filter button on the

Balance Tab.

Display Options

The Display button allows you to customize which fields you want to see on each tab.

Export to Excel

The Excel button allows you to export most tabs to MS Excel.

Data Entry

All data entry screens are accessible using the tabs below the buttons.
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3.6 Data Exchange

Plant Wizard exchanges data with JRP SSMS (Seed and Seedling Management System)

through syncing and, therefore, with other users who have appropriate access.

Plant Wizard desktop can import site data and planters from MS Excel, and export to MS

Excel from various screens and reports.

Data can also be exchanged with LRM, and exported to TFM and Phoenix Pro.

To access old Plant Wizard 7 files, .pw7 files can be imported into SSMS (one time), which

can then be synced with the desktop and mobile devices:

1. Login to an SSMS account and go to the Projects Tab.

2. Choose the Import Project (PW7) button.

3. Select a file and click the Upload File button.

3.6.1 Exchanging Data with SSMS and Other Users

All data is synced between the desktop and mobile devices using the JRP Seed and

Seedling Management System (SSMS) website. This requires an Internet connection when

syncing.

Payroll related data will also sync with SSMS for those users with payroll permission. All

users that share the same Payroll Code share payroll information.

Newly created data will always be sent to SSMS.

For more information, please refer to:

· the "Importing Seedlings from SSMS" section under Managing Seedling Information

· the "Exchanging Project Data with SSMS and Other Users" section under Managing

Projects

· the "Syncing" section under Plant Wizard on Mobile Devices

3.6.2 Exchanging Data with Excel

For information on importing data from Excel, please refer to the following:

· Importing Seeds - Seeds

· Importing Sites - Importing Site Data from Excel

· Importing Planters - Creating Planters
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For information on exporting data to Excel, please refer to the following:

· Seeds

· Sowing - Managing Sow Plans

· Seedlings - Exporting Seedling Data to Excel

· Sites and Prescriptions - Exporting Data to Excel

· Seedling Deliveries - Seedling Shipments / Deliveries and Sites

· Seedling Allocations - Allocation, Planting, Rates

· Tallies, Planter Work, Planters, Work Types - Payroll sections

· Allocations and Planting - Suitability, Allocation, Planting, Rate sections and Sites

· Seedling Balances - Seedling Balance

· Plots - Sites

· Reports - Reports

3.6.3 Exchanging Data with Mobile Devices

For information on exchanging data with mobile devices, please refer to:

· Syncing under Plant Wizard on Mobile Devices

3.6.4 Exchanging Data with LRM (formerly Resources)

For information on exporting data to LRM, please refer to:

· Exchanging Project Data with Resources

3.6.5 Exchanging Data with LRM (formerly TFM)

For information on exporting data to LRM, please refer to:

· Exchanging Project Data with LRM

3.6.6 Exchanging Data with Phoenix

For information on exporting data to Phoenix Pro or Phoenix Connect, please refer to:

· Exchanging Project Data with Phoenix Pro

· Exchanging Project Data with Phoenix Connect
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4 Managing Projects

Projects belong to SSMS accounts and are the basis for determining seedling needs for

future planting. A project is organized as follows:

· Projects (year, season, contractor, geographic region)

· Sites (planting treatment area, planting unit)

· Species Prescription (planned species mix ratios and desired seedling properties)

This data can be synced with SSMS, imported from a MS Excel spreadsheet, and/or

manually created in Plant Wizard. Sites and species prescriptions can also be created on the

mobile device.

Refer to the Navigation section to learn how to download, sync, filter, and view projects.

To archive or unarchive projects, please refer to the Projects section.

To create a project manually, please refer to the Projects section.

To import project data from a MS Excel spreadsheet, refer to Importing Project Data from

Excel.

To sync with SSMS, refer to Exchanging Data with JRP SSMS.

4.1 Projects

Everything project-related can be found under the Projects Tab.

Create Project

To create a project, select the Create Project button while on the Projects Tab:

1. Select the "Owner Account" you wish to create the project under.

2. Choose your "Planting Contractor" if they are using the payroll module. To

indicate a planting contractor after the project is created, you will have to edit the

project on SSMS.

3. Select the "Year" and "Season".

4. Enter a "Plot Multiplier". This number will be used in calculating densities from

planting plots.

5. Record a "Project Name". Be descriptive as this helps your planting contractor

differentiate between projects with the same year and season.
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6. Select the Create Project button.

7. Other project data, such as Permissions and Seedling Assignments will be

editable once the project is created.

Download Project

To download an individual project without going through the entire sync process, right-

click a project and choose "Download this project". You can download archived projects

as well, without having to unarchive them first.

Archive/Unarchive Project

To archive or unarchive projects with permissions, right-click a project and choose

"Archive this project" or "Unarchive this project". Archiving projects updates the SSMS

server and removes the project from everyone's view the next time they login or sync. For

payroll users, tallies and work for archived projects will still be visible on the desktop, but

not on the devices. This ensures that payroll contractors still have access to run their

payroll reports in the event that their client archives the project.

Delete Project

To delete a project locally, right-click on the project name and follow the prompts. Note:

Any unsynced changes will be lost! You can choose to delete and download, or just

delete.

Messages

If there is no Internet connection available, you will see a "No Internet Connection"

message along the top of the projects' tabs. Any of the live editing tabs or fields will not

be able to update the SSMS server data live.

If there are no seedlings assigned to the project, you will see a "No Seedlings are

Assigned to this Project" message along the top of the projects' tabs.

If the seedling assigned to the project differ from SSMS, you will see a "Seedlings

Assignments differ from the server. Please sync." message along the top of the project's

tabs. This usually happens if you or someone else have updated seedling assignments

while your computer was not connected to the Internet.
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4.1.1 Summary

The Summary Tab gives an overview of the project's progress.  

The "Planting Done" section summarizes prescribed, allocated, planted, delivered, and

tallied trees, densities, and species % mixes for sites where planting is completed. The "All

Sites" section is similar, however, it summarizes total trees for all sites regardless of

planting status.

The "Plots" section calculates by plot type, the # of plots, quality %, satisfactory %, excess

%, density, and confidence interval 90. A species % mix shows the ratio of trees recorded in

the plot regen section.

Using the Australia plotting system, the "Plots" section shows # of plots, quality %, fertilizer

quality %, density, and a species % mix.

The "Production" section is only available to payroll contractors and summarizes tallies as

total # trees, # trees per day, $ per day, and # of days by initials. The top row shows an

average planter production, while the second row shows an average daily production.

4.1.2 Seed

The Projects' Seed Tab lists all of seed available to the project selected:

· By default "Seed Label" is a frozen column.

· You can add new columns by selecting them at the base of the screen.

· You can move columns by selecting and dragging the column headers.

· "Allocated to Sites" is the number of potential trees allocated to sites within the

project.

· "Allocated other Projects" refers to the number of potential trees allocate to all

other projects within your database.

4.1.3 Seedlings

The Projects' Seedlings Tab lists all of seedlings available to the project selected:

· By default "Seedling Label", "Amount Assigned", and "Amount Assigned Server" are

frozen columns.

· "Amount Assigned" refers to the # of trees that are designated as available to that

project. This is required if your contractor needs access to seedlings. This number is

used for balancing trees on Planting and Balance Tabs and for creating shipments.

· You can live edit the "Amount Assigned" on the desktop if you have permission. If

you edit these values without an Internet connection, your values will be out of sync
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when you are back online. The "Amount Assigned Server" column displays the values

from the server. If you wish to update the server with your desktop values, use the

green arrow or sync the project and seedlings.

· You can copy the "Allocated to Sites" values into the "Amount Assigned" column

quickly by using the Assign all from Allocated button, or you can select the values

manually and copy/paste into the other column.

· You can add new columns by selecting them at the base of the screen.

· You can move columns by selecting and dragging the column headers.

· "Owned" equals the number of seedlings owned by the SSMS Account the project

belongs to.

· "Allocated to Sites" is the number of seedlings allocated to sites within the project.

· "Assigned to Other Projects (SSMS)" refers to the number of seedlings assigned to

all other projects. This connects directly to the server and can take longer to

calculate and draw.

· "Remaining" refers to the number of seedlings owned minus the number assigned

to all projects. This connects directly to the server and can take longer to calculate

and draw.

Add a New Seedling to the Project

Payroll contractors can use their own account, create their own projects, and assign or

create seedlings in cases where they need to access seedlings:

· owned by unmanaged accounts, or

· owned by managed accounts where the account owner DOES NOT use Plant

Wizard desktop or SSMS

To create or assign seedlings, go the Projects' Seedling tab:

1. Click on the Add a new Seedling to this Project button.

2. Type in the request key or Crop Name:

· If that crop name already exists on SSMS, you will be prompted to choose the

owner.

o If the owner is a managed account, you will be prompted to add a suffix

in the adjacent box to create a new seedling. You can use the seedlot and

species from the original (or enter different ones), then input the number

of seedlings.
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Your account will then own this new seedling. It will be assigned to the

"SSMS Nursery" to avoid confusion for the actual nurseries using SSMS.

You can ship from "SSMS Nursery" for your own record-keeping purposes

but the actual nursery will not be notified. 

o If the owner is an unmanaged account, you can use the existing crop

name and will have the option to use the seedling's seedlot and species

information and add the number of seedlings. This will assign those

seedlings to your project, but the seedlings will still be owned by the

unmanaged account. 

· If that crop name does not exist on SSMS yet, you can create it as a new

seedling.

1. You can then choose to use the seedlot and the species information from the

original crop name, or enter your own if you are inputting a new seedling.

2. Enter the number of trees you need for your project.

3. Your account will own all new seedlings, and they will be grown by "SSMS

Nursery". You can ship these trees from SSMS Nursery to your project if you wish

to track "Shipped" amounts. This is a fake nursery for tracking purposes only - it

will not receive notifications.

Caution should be used before creating a new seedling using this tool. If you have a

client who DOES use Plant Wizard, DOES manage their seedlings via SSMS, and has set

up the project for you via their account, you should use their project and seedlings. If you

need seedlings that your client has NOT assigned to the project, you should contact

them to sort this out. Creating your own project and seedlings is not data that is shared

with your client.

Unlink Seedlings

If there are seedlings showing up within the project that should not be there, it could be

because they are linked to the project in some way.

Users can unlink a seedling from a project using the Unlink Seedlings button in the

lower right of the screen. If there is related data that prevents the seedlings from being

unlinked, the user will be presented with a list of that data highlighted in orange.

Seedlings can be unlinked if they only have the following linking them:

· Project Assignments

· Contract Rates

· Planter Rates
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· Fertilizer Rates

· Site Suitability

· Site Suitability Tests Ignored

4.1.4 Permissions

Users can view what their permissions are on each project.

If you have account access and an Internet connection, you can edit these permissions:

· Set up access to a project by adding an individual contributor's email address. This

must be the same email address they use to login to SSMS online. If the user is not

setup online, they can go to www.jrpltd.com/Login.aspx and choose "Create a

Login".

· Check or uncheck the permissions you would like to assign or remove for each user.

· "Default Settings for Payroll Users" gives the same permissions to all users listed

within the payroll users account.

Permission levels are as follows:

· Basic - everyone has this

o Add sites, site notes, site costs, plots, deliveries, site secondary properties (where

blank)

o Edit "Planting Done", "Allocations Locked", "Start Date", "Finish Date", deliveries

o After syncing, cannot edit existing records

· Project Details

o Add/edit/delete project properties, project costs

· Project Seedlings

o Edit "Amount Assigned" on the projects' Seedlings Tab

· Sites

o Edit/delete sites, prescriptions, site notes, site costs

· Site Secondary Properties

o Edit/delete all other site properties

· Plots

o Edit/delete plots, plot regen, plot errors

https://www.jrpltd.com/Login.aspx
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· Planted

o Add/edit/delete planting records

· Planting Contract Rates

o Add/edit/delete contract rates

· Planting Schedule

o Add/edit/delete planting schedules

· Seedling Allocations

o Add/edit/delete site seedling allocations, including notes

· Seedling Suitability

o Edit site seedling suitability

· Account

o Add/delete/archive projects

o Add/edit/delete permissions and contributors

4.1.5 Planter Work

All planter work (other than tallies) and deductions for the selected project are shown and

recorded under the Planter Work Tab.

Planter work can also be recorded under the Payroll Tab.

4.1.6 Costs

Project costs can be viewed and recorded. These costs are summarized and distributed over

the sites by prorating by area and by tree on the sites' Costs Tab. To setup cost codes, go

to Setup > Code Lists.

4.1.7 Shipments

Shipments can be viewed on the Shipments Tab. Double-click the Shipment # to go

directly to that shipment on SSMS.

The main Shipments Tab has replaced this tab.

4.1.8 Details

To edit an existing project, go to the projects' Details Tab. To edit the payroll contractor,

please access the project on SSMS. Once a payroll contractor has been set, it cannot be

changed.
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Required fields:

Field Description Required

Name Identifier for the project Yes

Year Planting year Yes

Season Planting season Yes

Contact The main contact name for the project No

Email Contact's email address No

Phone Contact's phone number No

Fax Contact's fax number No

Plot Multiplier Multiplier used to determine plot density Yes

Max Seedling

Inventory

Specify how many seedlings a project location can

handle at any given time. Used in conjunction with

the Scheduling Tab.

No

Payroll Displays payroll contractor assigned to the project Yes (if contractor

wishes to track

payroll)

4.1.9 Sync History

Tracks each project sync with a username, date, and time. Each sync shows how many

changes were sent and received between the desktop and server. If any sites were moved,

this is also indicated.

If any errors occurred during the sync process, these will be indicated as well.

4.2 Sites

The Sites Tab lists all the downloaded sites associated with the account and year selected.

The user controls which fields (in which order) should be listed on the Sites Tab by using

the Display button. The data in the grid can be sorted by clicking the column header, or

filtered by clicking on the filter symbol beside the column header name.  
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Edit Site

Most data in the grid can be edited directly, or you can double-click or choose the Edit

button to use the Edit Site Screen. While editing a site, you can switch between sites by

selecting a different one from the grid in the background. 

View All

The View All button allows you to quickly see all deliveries, plots, and planting for all

sites within your view. Use the Jump to Site button to quickly go to the correlating Site

Editing Screen if you need to edit values. Export to Excel to manipulate data quickly

and do ad-hoc reporting. To move plots to another site, view all the plots, right-click the

plot(s) you wish to move, then select the site you wish to move it to.

Clone Site

To change which project a site belongs to, use the Clone button from the main Sites

Tab and select a different project. Cloning to a different project will copy all site-related

records including external IDs, prescriptions, allocations, plots, notes, deliveries, planting,

costs, suitability, and rates. If there is any payroll data associated with a site, the payroll

data will not be copied. This feature should only be used when everything is synced and

generally before any contractor data is recorded. The original site will still exist after

cloning until you manually delete it.

New Site

To create a new site manually, use the New Site button. Choose the project that the site

belongs to, then enter the appropriate details including Block Name, PU Name, Planting

Density, Area. Alternatively, you can use the Clone Site button to create a copy of a site,

including prescriptions, within the project you are working on. Cloning within a project

will not copy external IDs, allocations, plots, notes, deliveries, planting, costs, suitability,

or rates. Site and prescription information can be imported from a MS Excel spreadsheet

or from the SSMS website.

Delete Site

To permanently delete a site, use the Delete button. Please note that this will delete the

site from your local database and also remove it from the server the next time you sync
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(which will remove it for everyone). You will be notified of any site-related data that will

also be deleted. You must confirm before deleting. To delete multiple sites, drag-select

or [Shift]-select the sites, then use the Delete button. If a site has payroll data associated

with it, you will not be allowed to delete it (to protect contractor data).

Sites Screen:

The A% column and P% column show symbols that indicates how much of the site has been

allocated or planted. If you hover over each symbol, you will see more information.

Symbols and Highlighting:

"Planting Done" has been checked

No allocation and/or no planting

Partially allocated (less than 95%) hover over the symbol to see the details

Partially allocated or planted - hover over the symbol to see the details

100% allocated and/or planted

Site has been allocated and/or planted 105% or more - hover over the symbol to

see the details

A warning symbol to indicate numerous possible conflicts or deficiencies - hover

over the symbol to find out what the issues are

Plot Quality values will be highlighted green if they meet the "Planting Quality

Percent Requirements" entered under Setup > Account Preferences
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4.2.1 Details

When you double-click a site, or select one and choose the Edit button, the Edit Site

Screen will open. The site details or properties are listed down the right-hand side. These

can be reordered by dragging the headings up or down. You can show or hide this section

by using the arrow at the top to expand or collapse it.

Any fields that you do not have permission to edit will appear in grey. To see which

permissions are required to edit these fields, select the  button in the top right of the

screen:
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If you use auto allocate on the Planting Tab and want to ensure that certain sites are not

affected when using this feature, use the "Allocations Locked" checkbox. This will also

prevent allocations from being manually changes or deleted.

Check the "Planting Done" checkbox once planting is complete. If the start and finish dates

do not match the first and last planting dates, you will be prompted to use the Update

Start / Finish Date button.

The following table indicates how specific fields are used within Plant Wizard:

Field Description Required
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Planting Done Check to indicate that planting is finished, planted

#s will show on Planting Tab

No

Allocations Locked Check to prevent auto allocate from altering

allocation #s

No

Start Date First day of planting If updating other

databases; For

reporting

Finish Date Last day of planting If updating other

databases; For

reporting

Block Name Used to group planting units into one

management area

No

PU Name Name of site or planting area Yes

CP Name Cutting Permit name No

Ecology Biogeoclimatic zone of the site; used for GBST

suitability

No

BEC Variant Ecological classification of the site (zone, subzone,

and variant); used for CBST suitability

determination

No

Priority The relative order in which the site should be

planted

No

Seed Zone Class B seed zone; used for GBST suitability No

Min Elev The minimum elevation of the site; used for GBST

suitability

No

Max Elev The maximum elevation of the site; used for GBST

suitability

No

Latitude Latitude of the site (degrees, mins, seconds, N or

S); used for GBST suitability

No

Longitude Longitude of the site (degrees, mins, seconds, E or

W); used for GBST suitability

No

Area Size of the site (hectares, acres, etc.) Yes
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Current Density Number of stems per area pre-existing on the site No

Target Density The desired density on the site after planting. Used

to calculate "M" value if Target Density is blank.

Yes

Planting Density Number of stems per area to be planted Yes

Status A user-defined status of the site (to help with

determining which reports need to be run)

Displays when

selecting which

sites to include

in reports

Fund. Source Funding source for the planting activity For Potlatch

reports

District The district the site is located in For Potlatch

reports

External ID Fields related to external system linkages If updating other

databases
Ext. Act. ID

Ext. PU ID

$/Area Contract planting rate per area Fill in if using

area contract

rate

$/Day Contract planting rate per day Fill in for day

rate contract

Person Days Number of person days taken to plant the area Fill in for day

rate contract

WS Target Density Used to calculate "M" value if available, otherwise

uses Target Density

For Silv Label on

reports

Contractor Contractor name For Paycert and

for Potlatch

reports

Foreman Foreman name (or contract supervisor) For Potlatch

reports

Forester Forester name supervising plant For Potlatch

reports
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Site Index Site Index at 50 years For Silv/Inv

Labels on

reports

Stand Height Stand height For Silv/Inv

Labels on

reports

Stand Age Stand age For Silv/Inv

Labels on

reports

Crown Closure Crown closure % For Silv/Inv

Labels on

reports

4.2.2 Summary

The Summary Tab gives an overview of the site's progress.

The Date selection at the top allows you to filter to only show calculations from

information recorded on a particular date. "Prescribed", "Allocated", and the "Production"

are not date-specific so they always display everything. 

The "Density" section summarizes prescribed, allocated, planted, delivered, and tallied

trees, densities, and species % mixes.

The "Plots" section calculates by plot type, the # of plots, quality %, excess %, density,

confidence interval 90, planted %, natural density, and total dropped trees. A species % mix

shows the ratio of trees recorded in the plot regen section.

Using the Australian server, the "Plots" section shows # of plots, quality %, fertilizer quality

%, density, and the species % mix.

The "Production" section is only available to payroll contractors and summarizes tallies as

total # trees, # trees per day, $ per day, and # of days by initials. The top row shows an

average planter production, while the second row shows an average daily production.

4.2.3 Prescriptions

Enter prescriptions by specifying the species to be planted, preferred stock size, and % mix.

The Min % and Max % are optional and are used when auto allocating seedlings. If there is

not enough of one species to fill the site's needs, auto allocation will try to adjust the %

required up or down (within the specified range) to make up the difference.
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All seedlings available to your project will be listed under the appropriate species to show

you what is available for allocation. The seedling list shows each seedling's suitability

(coloured circle). If you wish to use A class seed for any species on this site, indicate the

seed zone under SZ-A. To assign a fertilizer code to a species, use the Fert. Code pull down

list, then specify what percentage of the species you wish to fertilize. The Fert. Code list is

populated by your entries under the Setup > Code Lists > Fertilizer Codes.

The total at the bottom will show Pref % in red when it does not add up to 100%. You can

also see your total required, allocated, planted, and to be planted.

Required Fields:

Field Description Required

Species Tree species Yes

Stock Size Seedling size No

SZ-A Class A Seed Zone No

Min% Minimum acceptable ratio of species to be planted No

Pref% % ratio preferred of this species Yes
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Max% Maximum acceptable ratio of species to be planted No

Required Number of estimated seedlings required calculated

as Area x Planting Density x Pref%

Yes

Allocated Indicates the number of trees by seedling label

assigned to the site

No

Planted Indicates the number of trees by seedling label

planted

No

To Be Planted Allocated minus Planted No

Fert. Code Indicates the fertilizer type to be applied to this

species

No

Fert. % Indicates the percentage of this species to be

fertilized

No

**Note:  A site that has no prescriptions will not show up on the Planting Tab.

4.2.4 Plots

The Plots Tab shows all the plot information which can be collected on a mobile device

and downloaded to the desktop, or entered directly into the desktop.  

The plot name will automatically increase as you add new plots (even if you use letters

before the plot number). Each plot is tracked with the initials of the user who entered it if

"Initials" are setup under Setup > Preferences.  

Default Plots:

Indicate the Plot Type as "Check", "Audit", "Survival", or other custom plot type name.

Planted, plantable spots, excess, satisfactory planted, unsatisfactory planted, non plantable

spots, dropped trees, latitude, longitude, penalty, and comments can be tracked at each

plot. Hovering your cursor over the abbreviated column headings will display the full title.

You can filter data based on initials, plot type, and/or date by selecting the filter symbol in

the column heading. The quality %, excess %, plantable %, satisfactory %, densities, and CI-

90 calculations at the top of the screen will change to reflect the filter(s) used.

Any plots where "Planted" does not equal "Satisfactory" + "Unsatisfactory" + "Excess" will

be highlighted in red.
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If your Account Preferences specify that you record naturals at the regen level, the "Regen"

section allows well spaced planted, total planted, well spaced naturals, and total naturals

by species. The total naturals will be calculated and displayed at the plot level as "Nat".

If your Account Preferences specify that you record naturals at the plot level, the "Regen"

section is hidden and you will record naturals by editing the number directly in the "Nat"

column. The total naturals will be calculated and displayed at the plot level as "Nat".

Species composition from planting and from plot regen (if available) can be viewed on the

Paycert report.

The "Errors" section records planting faults by species (optional). Error codes are specified

under Setup > Code Lists.

The top of the screen shows a number of plot calculations:

· "Quality" is measured as the number of satisfactory trees planted divided by the

number of plantable spots in each plot. The formula is set up this way in the default

Paycert report in Plant Wizard but can be modified to suit your own custom formula

for determining planting quality.

The Paycert report includes formulas for assessing penalties or charges against the

planting contractor based on quality and excess measures for the site. These

formulas are also user definable by modifying your own version of the report.  

· "Excess" is measured as the number of excess trees recorded divided by the number

of trees planted.
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· "Density" is measured as the number of trees planted plus the number of non-

plantable (NP) spots recorded in the plots. The 90% confidence interval ("CI-90") is

calculated with this number to provide an indication of accuracy in the numbers.

· "Plant" is measured as the number of trees planted divided by the number of

plantable spots. "Plantable" is the number of density of plantable spots. "Sat" is

calculated as the number of satisfactory trees planted divided by the number of

total trees planted. "Satisf" is the density of satisfactory planted trees. "Naturals" is

the density of total naturals (TN) recorded in the Plot Regen section, if applicable,

otherwise from the Plot "Nat" column. 

Australia Plots:

For users logging in to the Australian server, the Plot Tab will allow recording of above

ground, below ground, and fertilizer quality. There is checkbox to indicate whether or not

the plot is a final plot (in the case of re-plotting an area). Only final plots are used in

Paycert reports. "Final Plot" is checked by default when a plot is created - uncheck it if you

replace the plot with another. On the mobile device, rename the replaced plot, then

uncheck the "Final Plot" box on the desktop after syncing.

4.2.5 Wx/Soil

The Wx/Soil Tab allows users to track weather and soil conditions that are tracked by

date/time. Weather tracks % humidity, air temperature, wind speed and  direction,

precipitation, and whether or not it was cloudy. Under soil conditions, users can track

dry/wet status, 6" soil temperature, and whether or not there was snow present. General

comments can be used for further description.

These conditions appear on the Potlatch Daily Planting and Potlatch Planting Summary

reports.

4.2.6 Notes

The Notes Tab allows users to add, edit, or delete site-specific comments. You can specify

whether these are "Pre-Plant Notes" or "Post-Plant Notes". These appear with a username

and date/time stamp on the screen as well as on the Map Legends and Paycert reports.

Notes can also be entered on the main Planting Tab.

4.2.7 Deliveries

The Deliveries Tab shows all the site deliveries as recorded on the mobile device, or

entered on the desktop. These delivered amounts can be used in the Balance Tab to

reconcile planter tallies and planted amounts. The seedling list shows each seedling's

suitability (coloured circle), as well as amounts allocated and delivered for reference.
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Deliveries can also be entered on the main Planting Tab.

4.2.8 Planted

Add, delete, edit, or view all planting records for a site. You can add multiple planting

records at once for the same date. There is a checkbox to indicate if the planted seedlings

were also fertilized. The seedling list shows each seedling's suitability (coloured circle), as

well as the amounts allocated, delivered, planted, and tallied (visible only to payroll users)

for reference.

Planting can also be entered on the main Planting Tab.

4.2.9 Tallies

All planter tallies for the selected site are shown and recorded under the Tallies Tab. You

can enter more than one tally at once for any given day and planter. The seedling list shows

each seedling's suitability (coloured circle).

Tallies can also be recorded under the Payroll Tab.

Rates are highlighted if they do not match the default planter rate set in the Rates Screen

accessed from the mail Planting Tab.

4.2.10 Costs

The Costs Tab allows users to track site-specific costs. Cost codes can be added from

Setup > Code Lists.  

The summary at the top of the screen compiles all costs incurred for a particular site and

prorates any project costs by area and by tree. You can compare planned (allocated) costs

versus done (planted) costs.

4.3 Exchanging Project Data with Other Users

To share data with other Plant Wizard users, use the Sync button.

When syncing data with the desktop, depending on your project permissions and account

you are filtered to, any changes you have made on the desktop will automatically be

uploaded to the SSMS server and you will receive any changes from SSMS. New data will

always be added.

Depending on the permissions a user has, they may have access to an SSMS account and all

of its projects, or simply a project within an account. Account permissions allow users to

create and manage projects, shipments, trades, and seedlings. Project permissions allow

users to access project and seedling data and create shipments.  
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When syncing with SSMS, account users have access to sync all data, whereas project users

may be limited. Separate syncing access for sites, plots, planted numbers, planting contract

rates, seedling allocations, seedling suitability, site secondary properties, project seedlings,

and project details can be granted within the projects' Permissions Tab on the desktop or

from the Projects Screen on SSMS.

Payroll information (planters, tallies, work, planter rates) will only be available and sync if

you have the payroll module and have specified your payroll users on SSMS.

The example below demonstrates how data can be shared via SSMS with other users:
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4.4 Exchanging Project Data with Excel

Plant Wizard can import site information from MS Excel and export sites, seedlings,

allocations, payroll, and balance details to MS Excel.

4.4.1 Importing Site Data from Excel

To import site data from an Excel file, follow these steps:

1. Format the data for import.

· The table below shows the possible data that can be imported.  If your column

headers match those in the table, PW may find them automatically (regardless

of what order they are in).

· PlantingUnitName should be filled in for each row of data.

2. Choose File > Import from Excel > Import Site Data.

3. Select the Load Excel File button, navigate to the location of the Excel file, and

select 'Open'.

4. Choose the project to import the sites into from the pull down list.
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5. Switch to the Site Property Mapping Tab and match up the columns in the Excel

file with the fields that Plant Wizard is looking for (if not found automatically). PW

will remember this field mapping to aid in future imports.

6. Switch to the Prescription Mapping Tab and match up the columns for species

prescriptions. Select the check box for "Import prescriptions with 0% PrefMix" if you

wish to import any species that have no Pref % specified. You will need to manually

select Pref % in PW before being able to allocate seedlings.

7. Switch to the Preview Site Data Tab to quickly review the data. By default, only

new sites (matched by Site Label) are imported unless you select an option to

"Update Existing Sites" or "Import Duplicate Sites". "Update Existing Sites" will

update all mapped properties and replace existing prescriptions, whereas "Import

Duplicate Sites" imports all sites as new without any attempt to update existing

data.

8. Choose the Save Data button at the bottom of the screen.

Data Import Format of Site & Prescription Fields:

Column Header Field Description

Priority Planting order or priority for each planting unit

Area Number of units of area (up to 2 decimals)

ElevationHigh Maximum point of elevation on the planting unit

ElevationLow Lowest elevation point of the planting unit

TargetDensity The target density of stems

CurrentDensity The pre-existing number of stems per unit area

PlantingDensity The density to plant

PlantingDone TRUE or FALSE

Locked TRUE or FALSE

Latitude Latitude (in degrees to 2 decimals)

Longitude Longitude (in degrees to 2 decimals)

BlockName The block unit name

PlantingUnitName The name of the individual planting unit within a block
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CuttingPermitName The cutting permit name

StartDate Start date of planting

FinishDate End date of planting

SeedZone Geographic seed provenance zone (not considering

species) - B class seed

Ecology Biogeoclimatic zone

BECVariant Ecological classification, including zone, subzone, and

variant

Note Comments

Status The current planting status (Planned, Done, Trees

Ordered, etc.)

Location Site geographic location (text)

Mapsheet Mapsheet reference number

FundingSource Funding source 

District Forest district

Division Company division code

GLAccount General ledger account code

Tenure Forest tenure number (if applicable)

Timbermark Logging timbermark

Township Private land

Range Private land

Section Private land

ExternalID Block sequence number from an external system

ExternalActivityID Activity sequence number from an external system

ExternalPlantingUnitI

D

Planting unit sequence number from an external system

Licence Licence number
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MinimumSpacing Minimum spacing between trees (numeric)

PlantType Plant type code (ex. fill plant = FP)

SiteIndex Site index value

SiteIndexSource Site index source value

PersonDays Number of person days used to plant the planting unit

DollarsPerHa Dollars per area cost of planting (contract rate)

DollarsPerDay Day rate cost of planting (contract rate)

WellSpacedTarget The target stems per unit area of all trees (planted and

natural)

Spacing Preferred spacing between trees (numeric)

StandHeight Stand description

StandAge Stand description

CrownClosure Stand description

BudgetType Capital, Expense, etc.

Aspect Site aspect

SiteSeries Ecological site series

Contractor Planting contractor

Forester Forester supervising planting

Treatment

Compartment

RegenTargetSPH

DenudationType

RowSpacing

FileID Used to identify the block in Phoenix Planting & Regen

exports
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EstimatedTreesPlante

dPerDay

Used on the Scheduling Tab

SchedulingOrder Used on the Scheduling Tab to initially sort the sites

Species Prescribed species

Stock Size Prescribed stock type, size, age

Percent Prescribed species %

Seed Zone Class A seed zone (by species)

Rules:

· Column headings are not case sensitive.

· One planting unit per row.

· Species data in separate columns. The import allows 10 separate species.

· One file per project.

· The first line in the file must be the headings.

· All other lines in the file must be data.

4.4.2 Exporting Data to Excel

From the Sites Tab you can export the sites to Excel selecting the Excel button.

To export prescriptions, use the Planting Tab, add in the appropriate prescription

properties using the Display button, then export to Excel.

4.5 Exchanging Project Data with LRM (formerly Resources)

Planting data can be exchanged between SSMS and LRM (formerly Cengea Forest or

Resources) using the separate "Plant Wizard Resources DataLink" tool. Any desktop or

mobile device planting data must be synced with SSMS in order to be exchanged with LRM.

After installing this tool, you will need to configure the ConnectionSettings.xml file within

the installation folder (C:\ProgramFiles (x86)\JRP Solutions\Plant Wizard Resources

DataLink) using a text editor (Notepad, Wordpad, etc). It will look something like this:
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Add in the proper host and service names as highlighted above and save. The application

uses these values to connect to your Oracle database, so once they have been set and saved

you can successfully run the application.

Connecting:

Start the Plant Wizard Resources Data Link and you will be automatically connected to the

Resources Oracle database. Enter your email and password to login to the Plant Wizard

server (SSMS) and click the Connect button. Once both sides have green check marks

showing, select the Proceed button.

If you are prompted for a Resources Database Username and Password Override, please

contact JRP Solutions support.

To Get Data for Plant Wizard:
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1. Use the Get Data for PlantWizard Tab.

2. Select your Division, then the Operating Zone you would like to import data from.

This step limits the amount of data loaded into the DataLink from LRM in order to

speed up the data loading process.

3. Select a Plant Wizard Project on the left. If there are no projects listed, you will need

to create one in SSMS or on the desktop first.

4. A list of blocks and planting units from LRM will be selected from planned planting

(with a base code of ‘PL’) that matches the project year selected. This list excludes

any seedling protection (SE) or seedling fertilization (CG) activities.

5. If you wish, you can filter the data by Operation to narrow down the list of Blocks

and Planting Units.

6. Select the planting units you wish to import from Resources and use the 

 button. Planting Units that already exist in Plant Wizard as sites will be updated,

whereas new ones will be inserted.

· If a planting unit has already been imported into Plant Wizard, another copy will

not be made upon subsequent imports. New planting units within the same

planting activity from LRM can be added.

· Species prescriptions are imported once from LRM. If, after importing to PW,

changes need to be made to these prescriptions, make those changes in Plant

Wizard rather than LRM. Also, there is no benefit to allocating requestkeys in

LRM prior to importing into PW because that information is not brought into

PW.
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The following data from LRM will be imported into SSMS if it exists:

LRM Field PW Field

Name

Description

From Silv. Treatment - Details Tab:

Sila_seq_nbr Ext. Activity

ID

Hidden field in LRM.

Status Status

Technique Plant Type

Start Date Start

Completion

Date

Finish

Fund Srce Funding

Source

Comments Site Notes Comments will be imported into the site notes for

every planting unit associated with the activity upon

creation in PW.  If the planting unit already exists in

PW, subsequent imports will not update the notes.

From Silv. Treatment - Planting Units Tab

Plun_seq_nbr Ext. PU ID Hidden field in LRM.

Planting Unit ID Planting Unit Added only when PU is first created, it is never

updated.

Area (ha) Area (A)

Density (st/ha) Target

Density AND

Planting

Density

Contract Min

Spacing

Min. Spacing
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Contract Target

Spacing

Spacing

Species Species Added only when PU is first created, it is never

updated.

Trees Preferred Mix Percent of total based on species grouping.

Added only when PU is first created, it is never

updated.

From Block - Details Tab

Cutb_seq_nbr External ID Hidden field in LRM.

Block ID Block Name Added only when PU is first created, it is never

updated.

Location Location

Site Index Site Index

Lat Latitude

Long Longitude

Mapsheet ID Mapsheet

Seed Zone Seed Zone Seed Zone for ‘A’ Class seed populates SZ-A at species

prescription level.

SZ-A added only when PU is first created, it is never

updated.

Seed Zone for ‘B’ Class seed populates Seed Zone at

the planting unit level.

Multiple seed zones are listed, comma separated.

From Block - Allocation Tab

Mark Timbermark

Licence Tenure AND

Licence

Imports to the Tenure field and to the Licence field if it

is blank.
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Permit CP Name Added only when PU is first created, it is never

updated.

Admin District

Name

District From Cutting Permit screen

From Ecology - Details Tab

Classification

Zone

Ecology Uses the BGC Zone from the first Eco Unit found with

the largest area.

Elevation Min Min Elevation The minimum elevation of all Eco Units.

Elevation Max Max Elevation The maximum elevation of all Eco Units.

**Note:   The block’s overall lowest and highest elevations are brought in as the

planting unit’s low and high elevation points respectively. All planting units within the

same planting activity that are imported from LRM will have the same elevations.

To Send Data Back From Plant Wizard:

Data can be sent back to LRM for Planting Units that originated from LRM. If new planting

units are added in Plant Wizard, they will not be sent back to LRM.
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1. Ensure you have synced your Plant Wizard desktop and mobile devices with the

Plant Wizard server (SSMS). This will send all of your data to SSMS in preparation

for sending to LRM.

2. Use the Send Data Back From PlantWizard Tab.

3. Select a Plant Wizard Project on the left that contains data you wish to export to

LRM.

4. A list of blocks and planting units from LRM that have a match in Plant Wizard will

be listed. 

· If no corresponding block or planting unit from Resources is found to match the

site in Plant Wizard, you will see "Not Found" text in red. These sites will not be

exported to Resources.  

· If the associated planting activity in LRM has a status of "DONE", this will be

indicated at the block level and it will not be included in the update.

· If multiple planting units in Plant Wizard have the same Ext. PU ID entered, you

will get a warning message stating that more than one planting unit matches the

same record in LRM. You will need to either delete or change the duplicate Ext.

PU ID numbers, then sync, and try the export process again.

5. Choose which blocks in LRM to update.

6. A reminder message will pop up asking if you remembered to sync. At this point the

data from SSMS has already been loaded into the DataLink, so if you still need to

sync, do that now, then choose the Refresh from SSMS button before trying again 

Also, if you have left the DataLink window open while data on SSMS has changed,

you will need to use the Refresh from SSMS button (or close the DataLink and

reopen it).

7. Use the  button to send all planned and completed planting to LRM.

· This will update all the species prescriptions in LRM with the allocated species

from Plant Wizard for sites where "Planting Done" is not checked.

· This will update all the species prescriptions in LRM with the planted species and

request keys from Plant Wizard for sites where "Planting Done" is checked off.

· If a site has no allocation or planting records in Plant Wizard, the corresponding

planting units in LRM will not be updated.

· If all of the sites for a particular activity are marked as "Planting Done" the

activity in LRM will be updated to Done as well.

· If there are any new seedlings or seedlots used for allocation or planting in the

Plant Wizard sites being exported to LRM, those request keys and seedlots will
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be inserted into the appropriate maintenance tables in LRM and listed on the

right under "Seedlots/Seedlings Inserted from PlantWizard".

· When the update is complete, each block and planting unit will be listed with

the results of the export.  Note that when "Planting Done" is not set, some of the

data is skipped and not exported to LRM (Comments, Finish Date, Status,

Minimum Spacing, Target Spacing, Planting Quality %).

· Site Notes are grouped together for all planting units within an activity and sent

to the planting activity comments field when planting is done.

· If a planting unit from LRM does not exist in Plant Wizard, it will be left as is

during the update.

· The update will never insert or delete activities, or planting units in LRM.

The following data in Plant Wizard (via SSMS) is sent to LRM:

PW Field Name LRM Field Description

Silv. Treatment - Details Tab

Start Start Date Minimum start date of all planting units within the

same silviculture activity.

Finish Completion

Date

Maximum finish date of all planting units within the

same silviculture activity.  Sent only when "Planting

Done" is checked.

Project - Season Season

Fund. Source Fund Srce Unique funding source for all planting units within the

same silviculture activity, otherwise left blank.

Notes Comments Sent only when "Planting Done" is checked.  All site

notes from all planting units within the same

silviculture activity (trimmed to 3999 characters).

Area (A) Area (ha) Sum of all planting units.

Planting Done Status If all planting units within the same planting activity

have ‘Planting Done’ checked, status is set to ‘D’.

Silv. Treatment - Planting Units Tab

Area (A) Area (ha)
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Min. Spacing Contract Min.

Spacing

Spacing Contract

Target Spacing

Planted/Area

Allocated/Area

Density (st/ha) Total Planted/Area where "Planting Done", otherwise

Total Allocated/Area.

Plots: Planted

and Plantable

Spots

Quality (%) From plots: Sum of Planted/Sum of Plantable Spots.

Species Species If "Planting Done", uses planted species, otherwise

uses allocated species.

Planted or

Allocated

Trees If "Planting Done", uses planted #s, otherwise

allocated #s.

Seedlot Seed Lot If "Planting Done", uses planted seedlots, otherwise

allocated seedlots.

Crop Name Request Key If "Planting Done", uses planted cropnames, otherwise

allocated.

Planted or

Allocated

Pct If "Planting Done", uses % of planted #s, otherwise %

of allocated #s.

4.6 Exchanging Project Data with LRM (formerly TFM)

Planting data can be exported to LRM using the generic "LRM Export (XML)" under the

Exports Tab of the Reports Tab. The export produces an .XML file that can be used for

importing into LRM.  

You will be prompted for which plots to use when exporting data (Audit, Check, Survival).

The plot filter affects the calculated values sent to the XML file.

There are also custom exports for specific companies.

4.7 Exchanging Project Data with Phoenix Pro

Exports to Phoenix Pro are found in the Exports Tab under the Reports Tab:

· Planting data can be exported using the "Phoenix Planting Export" 



Managing Projects 53

© 2012 to 2020 JRP Solutions Ltd.

· Regen data (from planting plots) can be exported using the "Phoenix Regen

Export".

Both exports produces a MS Excel spreadsheet that can be used for importing into Phoenix.

You will be prompted for which plots to use when exporting data (Audit, Check, Survival).

The plot filter affects the calculated values sent to the spreadsheet.

Please note that Column A is populated with the "File ID" field found on the Sites Tab.

4.8 Exchanging Project Data with Phoenix Connect

Exports to Phoenix Connect are found in the Exports Tab under the Reports Tab:

· Planting data can be exported using the "Phoenix Connect Planting Export" 

· Regen data (from planting plots) can be exported using the "Phoenix Connect

Regen Export".

Both exports produces a MS Excel spreadsheet that can be used for importing into Phoenix.

You will be prompted for which plots to use when exporting data (Audit, Check, Survival).

The plot filter affects the calculated values sent to the spreadsheet.

Please note that Column A is populated with the "File ID" field found on the Sites Tab.
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5 Managing Seedling Information

Seedlings are created and tracked online using SSMS and synced with the desktop and

mobile devices to allow recording of seedling allocations, project assignments, planting

numbers, and tallies.

If you own trees grown by a nursery that uses SSMS, your trees will be entered by the

nursery. If you own trees that are not already in the system, you will need to manually enter

them on SSMS.

Payroll users please refer to the projects' Seedlings section for information on how to

create your own seedlings and assign them to your project.

In order to separate seedlings by project or contract, you must assign seedlings to a

project. Please refer to the projects' Seedlings section for more information.

5.1 Importing Seedlings from SSMS

To import from the Seed & Seedling Management System (SSMS) website, use the Sync

button, select "Sync all Seedlings", and then the Sync Seedlings button. You can sync

projects at the same time if you wish.

5.2 Exporting Seedling Data to Excel

To export the seedling data to MS Excel, select the Excel button at the top of the

Seedlings Tab.

5.3 Seedling Properties

Seedling properties can be viewed in the Seedlings Tab. The seedlings shown are those

that match the year or alternate year of the projects available within the current account

and year selected. Also included, are any seedlings that are already associated (assigned,

allocated, shipped, planted, tallied, or delivered).

Sync to get any seedling changes from the SSMS server.

Using the Display button, users can show more or less data and determine the order in

which to display it. 

Seedling items can be sorted by any of the columns provided in this screen by clicking

below the desired header of the column to be sorted. Items can also be filtered by

selecting the filter icon beside the headings. When filters are applied, they show in yellow.

To update any of the seedling properties, double-click on a seedling row, and use the Edit

Values Online button to make any edits. "Site Allocations and Planted" in the bottom left

of the editing window shows a breakdown of where each crop is being used.

http://www.jrpltd.com/Login.aspx
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The projects' Seedlings Tab allows users to view and update how much of each crop is

assigned to individual projects. This displays on the Planting Tab when viewing the

seedling balance by "Project Assignment".

5.4 Seedling Balance

The Balance Tab is used to view the balance by seedling, by individual or multiple projects

or accounts, for some or all of the sites. Using the Balance Filter button to specify which

records you wish to compare from which dates.

Seedling items are displayed on the right-hand side of the screen. Select the two columns

of data to be compared from the pull down lists at the top. Your choices are Allocated,

Planted, Tallied, Delivered, Assigned, Shipped, Planned/Shipped, and Owned. You can

double-click on any of the compared values to see a detailed breakdown. Tallied can be

shown as long as all projects in the filter have the same payroll account linked and your

login has access.

5.5 Seedling Shipments / Deliveries

Seedling shipments and deliveries are used to record the movement of seedlings as they

travel from the nursery to the field.  

· Shipments - creating and editing shipments is done through the main Shipments

Tab (or online with SSMS). Use the Refresh button to update information from the

SSMS server.
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· Site Deliveries - on the sites' Deliveries Tab, you can record trees deliveries taken

to and from individual sites. These numbers are commonly used to reconcile tree

planter claimed numbers on the Balance Tab.  Site deliveries can also be recorded

on the handheld. You can record deliveries by initials for better tracking.

To export seedling deliveries, go to the Sites Tab and use the View All button to select

"Deliveries". You can then export the results to Excel.
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6 Suitability, Allocation, Planting, Rates

From the Planting Tab you can edit and/or view seedling suitability, allocation, planting,

deliveries, and rates.  

Navigating the Planting Tab:

· In the matrix, the projects, sites, and prescriptions are listed down the left side, while

the seedling details are listed across the top.

· You can choose which site and prescription fields (in which order) you would like to

show on the left, and which seedling fields you would like to see along the top by

using the Display button.  Some fields are recommended to give you optimal

viewing. Using the Restore Defaults button will automatically select and sort the

recommended site headers.

· Using the Display button, you can choose how you would like to calculate your

seedling balance, as well as select other options for viewing (with shortcut keys):

o Seedling Balance:

§ Owned - this will use the number of trees owned by the account and subtract

any allocation (where planting is not done), and planting numbers (where

planting is done).  For reference, you will also see "# Prj. Assigned", which

shows how many trees are assigned to the projects within your view, "Used

Elsewhere", which indicates how many trees are allocated to sites in projects

not in your view, and "Used", which sums all of the site allocations for the

projects within your view. 

§ Project Assignment - this will use the number of trees assigned to the projects

within your view and subtract any allocation (where planting is not done),

and planting numbers (where planting is done). You will see "# Owned" for

reference as well. 

§ Shipped - this will use the number of trees shipped to the projects within your

view and subtract any allocation (where planting is not done), and planting

numbers (where planting is done). You will see "# Owned" and "# Prj.

Assigned" for reference as well. There is an option to include planned

shipments as well.

o Additional Info [Ctrl-I to cycle]:

§ None - does not show any additional information in the cells.

§ Show Number of Boxes in the Cells [Ctrl-B] - shows the estimated number of

boxes allocated (or planted if done) in the upper left corner of each cell. This
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is calculated based on the number of trees per box. When this option is

selected, a hover hint will appear showing the calculation.

§ Show Seed Sown From Sowing Page - shows the number of trees that were

requested to be sown for the seedlot in the upper left corner of each cell.

Desired Nursery must match the grow nursery (or be blank).

§ Show Tallies - shows the number of trees that were tallied in the upper left

corner of each cell.

o Seedling Column Width (in characters) - sets the width of all the seedling

columns to a standard width.

o Show Details Tool Tip when mouse is over a Cell [Ctrl-T] - when your mouse

moves over cells in the grid, you will see a popup with details of that cell,

including sowed, allocated, planted, fertilized, contract rate, planter rate, tallied,

and suitability (depending on your permissions).

o Show surplus Seedlings available on SSMS - is there is an Internet connection, any

seedlings marked as surplus that match the year and season of the loaded

projects will show in separate columns. These will match on Year/Season, Alt

Year/Alt Season, or Override Year/Override Season if specified. These seedlings

cannot be allocated or planted, but are shown in order to help the user identify

potential seedlings purchases to fill any shortages.

o Site Planted amounts [Ctrl-P]:

§ Show only if Planting Done - numbers shown in the grid will be allocated

numbers if planting is not done, otherwise planted numbers will show.

§ Show all planted amounts - numbers shown in the grid will be planted

numbers only regardless of planting status. Balances will use planted

numbers only.

· Some display options are available at the top of the screen for quick access:

o One Row per Site [Ctrl-R] - rather than viewing as one row per species

prescription, you can view one row per site. This will collapse all species to be

listed on one row together.

o Show Planted Only [Ctrl-P] - numbers shown in the grid will be planted numbers

only. Balances will use planted numbers only.

o Hide Note Indicator [Ctrl-N] - with this selected, you will no longer see a little

green triangle appear in the upper right corner of the grid cells where a note has

been entered.



Suitability, Allocation, Planting, Rates 61

© 2012 to 2020 JRP Solutions Ltd.

o Hide Unassociated Seedlings [Ctrl-H] - this will hide all seedlings along the top

that are not directly related to the projects or sites in your view.  This includes

project and site allocations, deliveries, planting records, contract rates, planter

rates, tallies, and notes.  Click on the "i" button to see what this includes.

· Click on any heading column or row heading to sort data.

· Click on the filter icon beside any heading name to filter the data. To limit your view

to just the species you are working on, filter the species column or row. 

· Allocations can be entered directly into the grid, whereas you must double-click to

add planting and delivery numbers.

· Right-click a cell to quickly set suitability or to allocate trees.

· The Allocate button is used to allocate seedlings to sites using the seedling

suitability saved for each cell.

· The Suitability button sets the seedling suitabilities on each cell based on the

suitability criteria you have selected along the bottom of the screen.

· The Rates button allows you to set contract, fertilizer, and planter rates.

· The Scenarios button allows you to manually save your current seedling allocations

in case you need to restore them later. Any time you perform an auto-allocation, a

snapshot will automatically be taken just prior to the allocation and saved as a

scenario.

· Export or Save to Excel using the Excel button.

· For quick navigation, you can go directly to a Planting Unit by double-clicking the

Site Label. Leaving the Site Editor open, you can also navigate between sites by

selecting another one from the grid in the background.

· For quick navigation, you can go directly to a seedling by double-clicking it.

· When a site is marked as "Planting Done", the planted numbers for that site will

appear in the grid and be accounted for in the balance. You will not be able to edit

allocation for these sites.

Symbols:

Allocations are locked

"Planting Done" has been checked

No allocation and/or no planting
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Partially allocated (less than 95%) hover over the symbol to see

the details

Partially allocated or planted - hover over the symbol to see the

details

100% allocated and/or planted

Site has been allocated and/or planted 105% or more - hover over

the symbol to see the details

A warning symbol to indicate numerous possible conflicts or

deficiencies - hover over the symbol to find out what the issues

are

6.1 Suitability

Suitability criteria are listed along the bottom of the screen. 

Elevation, Latitude, Longitude, Seed Zone, and Ecology are used to determine suitability

using the GBST (geographic-based seed transfer) system. When using these criteria,

seedlings are assessed using all of the criteria selected to determine if they are suitable to

be planted in any of the sites.

If BEC Variant is selected, Plant Wizard ignores any other criteria that may be selected. BEC

Variant is used to determine suitability using the CBST (climate-based seed transfer)

system. The site BEC Variants are compared to each seedlot's area of use BEC Variants to

find a match, and if a match is found, the seedling is considered suitable on that site. 

If no criteria are selected, no suitability determination is made.

Geographic Suitability Criteria:

· Elevation - seedlings that have an elevation range that covers the site's elevation

range will be considered suitable

· Elevation buffer (-/+) - using the "-" buffer field allows the seedlings to be moved

below their minimum elevation by the amount entered, while using the "+" buffer

field allows the seedlings to be moved up past their maximum elevation by the

amount entered.

· Latitude - seedlings that have a latitude range that covers the site's latitude range

will be considered suitable. If the minimum and maximum latitude for a seedling

are identical (but not zero), latitude will automatically be considered a match for

that seedling.
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· Longitude - seedlings that have a longitude range that covers the site's longitude

range will be considered suitable. If the minimum and maximum longitude for a

seedling are identical (but not zero), longitude will automatically be considered a

match for that seedling.

· Seed Zone:

o for Class B or B+ seed, SZ-B recorded at the site level must match a seed zone

for a particular seedlot to be suitable

o for Class A seed, SZ-A recorded at the species prescription level must match a

seed zone for a particular seedlot to be suitable

· Ecology - evaluated for Class B seed only, if the SZ-B does not match the seedlot's

seed zone, but ecology does, the seedlot will be considered suitable

Climatic Suitability Criteria:

· BEC Variant recorded at the site level must match a BEC Variant for a particular

seedlot to be considered suitable

All seedlings are defaulted to suitability "Not Set" until either suitability criteria are

selected and the Suitability button is used, or suitability is manually set. Once you start

selecting suitability criteria, the cells will change colour so that the right half of the cell

shows the currently saved suitability, while the left half shows the live suitability based on

the criteria selected.

Matrix Color Coding:

Light Green Preferred (criteria match and seedling stock size

is found within the planting unit stock size)

Pink Suitability not set

White Suitable

Light Grey Unsuitable

Light

Orange

Current selection

Seedlot was sown for this site and nursery

matches
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Manually change seedling suitability by double-clicking the cell and changing suitability, or

right-click to change suitability.  

If you are using a particular criteria, ensure you have the necessary data entered in the sites

and seedlings in order to make a proper determination. If you check on "Ecology",

seedlings will try to match based on ecology if the seed zone match fails for B class seed

only. Fields that turn green show that the seedling item is preferred on that planting unit

because the seedling stock size is found within the planting unit stock type. If you use

latitude suitability criteria, any seed that has the same (but not 0) minimum and maximum

values will match automatically as long as the other selected criteria also matches. The

same is true for longitude. SPAR data accounts for latitudinal and longitudinal seed transfer

guidelines and sets minimum and maximum latitude and longitude values the same where

they are not pertinent.

Use the Suitability button to set the suitability on all site-seedlings to what is calculated

using the suitability criteria you have selected. All cells will become the colour indicated in

the left half of the cell.

If any seed was sown for a site using the Sowing Tab, the cell will be outlined in purple if

the seedling nursery matches the desired nursery.

The Planting Tab has a feature to check how many seedlings have been allocated or

planted in unsuitable locations. Hover over the Unsuitable icon  in the bottom right

corner of the screen.

Hover over any cell to see the suitability of all criteria, regardless of the suitability criteria

selected. To activate the hover hint, use the Display button to check the box for "Show

Details Tool Tip when mouse is over a Cell", or use the Ctrl-T shortcut.

To view the suitability details for a site-seedling combination, double-click on a cell to

bring up the Association Details Screen. Under the Suitability Tab, you will see all of the

seedling characteristics listed on the left and the site characteristics listed on the right, with

a "Test Result" listed for each. If there are any suitability tests that you wish to ignore for a

particular site-seedling combination, check the "Ignore" box.

Seedling suitability is visible when selecting seedlings for Deliveries, Planted, and Tallies,

and on the Prescriptions Tab.

SPAR data:

Class A and B+ Class B

Min / Max

Elevation

The intended range of use for

the lot.

Transfer limits have been applied to the

mean elevation at the time of lot
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registration to indicate the allowable

range of use for the lot.

Min / Max

Latitude

Will only have a minimum and

maximum latitude if they are

from a coastal seed planning

zone.

Transfer limits have been applied to the

mean latitude at the time of lot

registration, to indicate the allowable

range of use for the lot.

Min / Max

Longitude

Will not have minimum and

maximum longitude values.

Transfer limits have been applied to the

mean longitude at the time of lot

registration, to indicate the allowable

range of use for the lot. Only lots from

interior seed planning zones will have

minimum and maximum longitude values.

6.2 Allocation

Plant Wizard is designed to manually or automatically allocate seedlings to sites. The

seedling balance can be determined from seedlings owned, project allocated, or shipped

by using the Display button.

From the Planting Tab, you can allocate seedling by entering a number in the grid where

the species and prescriptions match.

If you double-click a cell in the grid or right-click a cell, you will be presented with more

options. You can choose to allocate "All" which will allocate all the seedlings needed or

available of that species, or "All Site Needs" which will allocate all the seedlings needed for

the entire site based on availability.

If allocations are locked on any site, you will not be able to manually or automatically

update the allocation numbers for it.

The # of boxes is shown calculated as allocation divided by the number of trees per box.

Use the Round button if you wish to round the allocation number to the nearest box.

You can also allocated seedlings on the Edit Site Screen by entering a number under the

Allocated column of the Prescriptions Tab.

The Allocate button is used to automatically assign available seedlings to suitable sites.

The objective is to fit selected seedlings to the selected sites in order of site priority (1

being highest priority). Only sites and seedlings selected in the Auto-Allocate Seedlings

Screen will be included in the allocation. Sites marked as "Allocations Locked" are not

included as options in the auto-allocation. There is a checkbox to "Consider Sowing

Allocations" which will try to allocate to seedlings where the seedlot was sown and the

desired nursery matches the grow nursery (or is blank).
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Users can allocate against seedlings owned or seedlings assigned to the project(s)

depending on how the seedlings are being balanced using the Display button. If you

balance against shipped and use auto-allocate, it will allocate to owned but balance to

shipped (and planned shipments if selected). When auto-allocating with project assigned

selected, each project assignment is considered individually in the allocation process.

To delete allocations, you can drag-select multiple cells and use the [Delete] button on

your keyboard.

Set your site-seedling suitability first for best results.

6.3 Planting

The number of seedlings planted in each site is recorded in the Planting Tab. Alternatively,

you can record planting under the sites' Planting Tab.

Double-click a cell to record planted numbers, notes, and fertilizer application. You can

reference the total site deliveries and tallies from this screen.

Navigating and color coding tips are provided in the Suitability, Allocation, Planting, Rates

section.

When planting is completed for a site, edit the site and check "Planting Done". This will

check to ensure that the start and finish dates match the planting dates.

6.4 Rates

Using the Rates button, users can set the contract rate, fertilizer rate, and planter rate.

Values can be drag-filled and/or copy and pasted within the grid.

Planter rates are only visible to payroll contractors. The planter rates are used as the pay

rate in the Tallies Tab and in the Payroll reports.  

Contract rates are used in the Schedule B report, the Planting Invoice report, and the

Paycert report.

You can drag columns at the top to change the sort order, and you can hide rows with no

associated allocation or planting records by checking the box at the bottom.

Export values to Excel by using the Excel button in the top right corner.

Rates can also be seen on the Association Details Screen that opens when users double-

click on a cell within the Planting Tab grid.
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7 Scheduling and Shipments

With the Scheduling Tab and Shipments Tab, users can schedule planting and project

shipments to ensure an adequate supply of seedlings.

7.1 Scheduling Trees

Manually schedule planting, or use the Auto-Schedule button to schedule planting based

on the trees per day entered and the scheduling pattern chosen.

Planned (and Shipped) shipments add to the seedling inventory. This works from shipments

downloaded to the desktop from the SSMS server.

When planting numbers are entered for a particular day (does not matter which site), it is

assumed that all planting numbers are up to date as of that date, and planning resumes

after it.

Right-click a scheduling cell to Auto-Schedule that site, Auto-Schedule Cascade to schedule

from the selected site down the list, or Enter Actuals which will open the Site Editor to the

Planting Tab.

Scheduled amounts are highlighted in orange if there are not enough seedlings to fulfill the

planting requirements. Hover over the cell to see the seedling shortages, or use the

Required button to get a list of shortages and what locations contain the seedlings you

need.

Total Balance cells are highlighted in red if the total inventory of seedlings is more than the

“Max Seedlings Inventory” specified in the Projects' Details Tab.

Change the order of sites by clicking and dragging the grey square beside the site label, or

use the Sort button to choose a sorting option.

7.2 Seedling Shipments

Shipment on the desktop are similar to shipments on SSMS. SSMS shipments are updated

when the desktop is synced. Desktop shipments are updated when the desktop is synced

and/or when the Refresh button is used.

When shipping to a project, the 'Project' list under Shipment Destination only includes

projects within the filter year.

Only shipments to the project are shown.

Refer to Seedling Shipments / Deliveries for more info.
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8 Sowing

Create a project for each account, year and season for sowing seed. If foresters have

different geographical areas that they like to manage separately, these can be further

broken down into projects as well. These projects will be used for the purposes of creating

sow plans, but will also provide the basis for planting when time comes.

There is a Sowing Needs Report that summarizes all the seed needs for any projects and

accounts that you select. You can choose to combine projects on the report or keep them

separate.  If you combine them, any seedlot required by sites from different projects that

has the same desired nursery and stock type will be combined in one row and the Project

column will list "Multiple". "Seed Needed" is calculated as Total / Seeds Per Gram (or

Pound) x Sow Factor x Oversow Factor. Users must fill in the desired Sow Factor and

Oversow Factor manually if needed (highlighted in orange).

To specify which units of weight to use, go the Setup menu and choose Preferences. Select

either "Use Metric Weight Units" or "Use Imperial Weight Units". This will change the

display of the units, and converts the amounts from one unit to the other.

8.1 Seeds

Seed does not sync with the SSMS server, instead it exists only in the desktop database. To

create a seed list, you can either create new seed manually using the New Seed button,

download seed from SSMS using the Download button, or import SPAR spreadsheet data

using File... Import from Excel... Import Seed Data.  

To create a new seedlot, give it a name and choose a species. Fill in the relevant

information, including Reserve Potential Trees. You can use the "Calculate Reserve Potential

Trees" section at the bottom to determine potential trees from the Grams Reserved. To use

this feature, the seedlot needs Grams (or Pounds) Reserved, Seeds Per Gram (or Pound),

Germination Rate, and Purity. Germination Rate and Purity will be assumed at 100% for this

calculation if they are left blank. If you wish to apply a sow factor, use the second

calculation.

You can also use the Set All Potential Trees button to calculate the Reserve Potential for

all seedlots at once.

If you download seed from SSMS, you can select which accounts to download seed for.

Seed owned by or shared with the selected accounts will be downloaded. The Reserve

Potential Trees will be automatically calculated upon download as Grams (or Pounds)

Available x Seeds/g (or lb). The calculation will also use Germination Rate and Purity if they

are entered. 

* Recommended for BC Users * - Importing seed from a SPAR extract allows you to choose

the seed owner and locations you are interested in:
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1. From the SPAR website, go to Reports -> Extracts -> Seedlot Extract and request

both the SPRX503-SeedlotExtract and the SPRX503-

SeedlotExtractForCBST_AreaOfUse reports by seedlot owner. These reports will be

saved with a date/time stamp.

2. In PW, choose File > Import from Excel > Import Seed Data.

3. Choose the Browse button to find the Extract Report prefixed with

"SeedlotExtractReport".

4. Choose the next Browse button to find the Area of Use Report prefixed with

"SeedlotExtractReportForCbstAreaOfUseReport".

5. Under "Select SPAR Owner/Locations to Download Reserve Seeds for", select only

those owners and locations that you wish to import BOTH reserve and surplus seed

for. To see the locations for an owner, expand the list by clicking the arrow beside

the owner name. 

6. If you wish to download surplus seed from all other owners (those not selected),

check the box for "Download SPAR Surplus Seed for ALL Owner/Locations". This

includes surplus for owners and locations not selected. 

7. Choose whether or not you would like to "Overwrite Existing Seed Data".

8. Choose the Import button at the bottom of the screen.

Importing seed from SPAR or downloading from SSMS automatically prioritizes the

seedlots. There is also an Auto-Prioritize button that will run through all seed in your

database and assign them a priority.  Priority is given as follows:  

· 2 = Owned A Class

· 3 = Surplus A Class

· 4 = Owned B+

· 5 = Surplus B+

· 6 = Owned B Class

· 7 = Surplus B Class

To delete seedlots, select from the list (multiples can be selected using the Shift key or click

and drag), and use the Delete or Delete All button.

To export the seed list to Excel, use the Excel button in the top toolbar.
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8.2 Managing Sow Plans

Sow plans are managed as projects created for the expected year of planting. Each project

needs a list of the sites expected to be planted. These projects can then be reused later for

planting purposes which provides the added benefit of seeing which seedlots were

originally sown for each site.

Seed allocations, suitability, and desired nursery are synced with the SSMS server, however,

seedlots are not. Seed lists must be created on each desktop separately.

The Sowing Tab displays similar to the Planting Tab. Sites are listed down the left and

seedlots are listed across the top. If a seedlot has been allocated to a site, but the seedlot

does not exist in the current desktop database, the seedlot will still appear across the top. If

the user clicks on the header, they will be prompted to create the seedlot and fill in the

details. This prevents a seedlot being assigned on one desktop and being missed on

another. If an allocated seedlot is not in the database, the user will see an allocated amount

highlighted in red with a tool tip warning appearing if they hover their cursor over it (if this

option is active in the Display Options).

Using the Display button, you can choose how you would like to display your data and

calculate the seed balance:

· Under "Site Headers", you can choose which site and prescription fields (in which

order) you would like to show on the left, and under "Seed Headers" you can select

which seed fields you would like to see along the top.

· Under "Balance Against", choose which accounts and projects you want to consider

when balancing potential trees and seed amounts.

· One Row per Site [Ctr-R] - rather than viewing as one row per species prescription,

you can view one row per site. This will collapse all species to be listed on one row

together.

· Show Details Tool Tip when mouse is over a Cell [Ctrl-T] - when your mouse moves

over cells in the grid, you will see a popup with details of that cell, including

allocated, suitability, and a warning when seed is allocated that does not exist in

your database.

· Use Surplus Seed - Select this option if you would like to use surplus seed where it is

available. Seed usage will be balanced using surplus and reserve combined. If not

using Surplus Seed, seedlots with only surplus seed amounts will be hidden from

view in the Sowing Tab and the auto-allocation window.

· Hide Unallocated Seed - Seed that has not been allocated to any sites will be hidden

from view.
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· Hide Seed that is not Suitable or Preferred - Seed that is not suitable or preferred will

be hidden.

Suitability and "Apply Suitability" works the same as Seedling Suitability with the exception

of “Preferred” being fully manual.

Auto-allocate works similar to the same function on the Planting Tab. Sowing auto-

allocation allocates in order of seed priority and descending potential trees to sites in

order of suitability and priority. The seed list in the auto-allocate window is narrowed down

to relevant species.

Double-clicking a cell allows users to select the "Desired Nursery" to sow seed at. Much of

the other functionality is the same as within the Planting Tab.

Scenarios can be saved of the Sowing Tab to aid in backing up data. Scenarios can be

restored if needed, overwriting existing data.

To export the sowing matrix to Excel, use the Excel button in the toolbar.



Part

9



Payroll 75

© 2012 to 2020 JRP Solutions Ltd.

9 Payroll

Planters, tallies, work, and planter rates can be recorded and reported within Plant Wizard

for users that have the Payroll Module. This allows contractors to use the payroll functions

in Plant Wizard. Payroll users that have edit permissions can edit and sync any payroll-

related changes, whereas other payroll users will only be able to view data.

Payroll users also have Planting Schedule permissions by default on projects they are linked

to. This can be turned off manually.

From the Payroll Tab, you can use the Payroll Filter button to specify your date range and

planters that you wish to include or hide. This filter affects all tabs within the Payroll Tab,

including the Reports Tab. Custom date ranges cannot exceed 5 years.

When setting the custom date range, you can use the Skip buttons to move back or

forward the same number of days in your original date range.

Every project (including archived projects) that contains tallies or work records will be

displayed and available to use from the Payroll Tab.

** Note:  Plant Wizard produces gross payroll numbers (which can be exported to

Excel). It does not do source deductions as required by most government agencies.

9.1 Planters

To add or edit planters, go to the Payroll Tab and either use the Edit Planters button at

the top, or use the Planters Tab and double-click on a planter to bring up the Edit

Planters Screen. Click on the Add New Planter button and enter enough information into

the "Name" field to help you identify different planters with the same name. This is the field

used when entering tallies and work on the desktop and mobile device.

The remainder of the fields are not necessary to fill out unless you want them as reference.

Please note that planters' SIN#s are never displayed on the mobile device.

Alternatively, you can import a planter list from MS Excel by going to File > Import from

Excel > Import Planters from the main menu. You can also export a list of planters to Excel

using the Excel button.

Archiving planters removes them from your list of planters to choose from when entering

tallies and work, but also removes them from all payroll screens and reports. Archiving

data, archives it for everyone you share payroll data with. This feature should only be used

if you have run all necessary payroll reports for those planters, typically at the end of the

planting season or before the start of the next season if the planters no longer work for you.
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A list of favorite planters can be created on the mobile devices under the Payroll Screen

by clicking on the star beside the planter's name. Planter lists on the Tallies and Planter

Work Tabs will show the favorite planters listed at the top and alphabetically sorted.

9.2 Planter Rates

Planter rates can be accessed using the Rates button on the Planting Tab and are used by

the planting contractor to determine payment to the individual planters and their overall

planting costs. Prices are recorded for each seedling and planting unit combination. These

rates are only visible to payroll contractors. The planter rates are used as the pay rate in the

Tallies Tab and in the Payroll reports. If rates do not match between the Edit Rates

Screen and the Tallies Screen, they will be highlighted in yellow.

Prices can be stored to four decimals and are recorded as dollars per seedling.

9.3 Planter Tallies

Entering or viewing planter tree tallies on the desktop can be done from the Tallies Tab

within the Payroll Tab:

1. From the Payroll Tab, select the the Tallies Tab.

2. Use the Payroll Filter button to specify your date range and planters that you wish

to include or hide.

3. Choose the New button and fill in the details including project, site, date, initials,

planter, rate, and amount. Note that you can enter tallies for multiple seedlings at

once. The rate will automatically fill in if you have the planter rate filled out in the

Edit Rates Screen on the Planting Tab. Rates will be highlighted yellow if they do

not match the default planting rate. The new tally will default details from the

previous tally entry in order to speed up the process, however, these values can be

changed.
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You can filter and sort data by clicking below the column headings. Data can be exported

to Excel using the Excel button.

Use the Work Tab to record other types of planter pay and deductions.

Planter tallies can also be entered or viewed on the Tallies Tab within the Edit Site Screen

on the desktop, or on the mobile device.

Total tallies can be turned on for reference in the Planting Tab grid using the Display

button.

9.4 Work Types

Work Types define all types of work, besides tree planting tallies, that planters would get

paid for (or pay deductions). Under the Payroll Tab, you can use the Edit Work Types

button to add new work types, assign a default pay rate (positive or negative), and specify

a sequence number to determine the list order.

These work types are used under the Payroll Tab when recording work, and under the

projects' Planter Work Tab.
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If there are any unpaid work types that you need to track amounts for, you can leave the

"Default Rate" blank. This works in cases where you need to track hours worked without

additional payment.

Any work types no longer used or needed for payroll reports can be archived using the

Archive Work Types button.

9.5 Planter Work

Entering or viewing planter work on the desktop can be done from the Work Tab within

the Payroll Tab:

1. From the Payroll Tab, select the the Work Tab.

2. Use the Payroll Filter button to specify your date range and planters that you wish

to include or hide.

3. Choose the New button and fill in the details including project, date, initials,

planter, site (which is optional), rate, and quantity. Note that you can enter multiple

work records at once for the same day and planter. The rate will automatically fill in

if you have the default pay rate filled out in the work types table. The new work

records will default some details from the previous work entry in order to speed up

the process, however, these values can be changed.

You can filter and sort data by clicking below the column headings. Data can be exported

to Excel using the Excel button.

Planter work can also be entered or viewed on the Planter Work Tab within the Projects

Tab on the desktop, or on the mobile device.

9.6 Payroll Summary

Under the Payroll Tab, the Summary Tab shows you (for your filtered date range and

planter list) daily total $, work $, tally $, or tally # records by planter or initials. Use the pull

down lists to determine grouping and cell values. Totals are calculated for each row and

column. Export this data to Excel using the Excel button.

9.7 Payroll Reports

To generate gross payroll numbers and reports, follow the steps below:

1. Enter the planters as per the 'Planters' section.

2. Enter the planter rates for each site and seedling as per the 'Planter Rates' section.  
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** Note: It is advisable to enter prices for all areas that will be planted before planting

commences. This ensures that the default rate is used automatically when new records

are created.

3. Sync your desktop, then any mobile devices.

4. Record planter tallies and work as per the 'Planter Tallies / Work' section.

5. Sync the mobile devices, then the desktop.

6. To view tallies on the desktop, go to the Tallies Tab under the Payroll Tab. You

may have to adjust your Payroll Filter for date range and planters.

7. Tallies can be viewed on the desktop by project. The Tallies Tab can be sorted by

clicking on the column headers, or by exporting to Excel and sorting there.

9. To add different 'Work Types' and their default pay rate, simply go to the Projects

Tab and select the Work Types button. 

10. Once all of the data is in the desktop (via sync), payroll numbers can be generated

according to your needs. To generate payroll reports go to the Payroll Tab and

choose the Reports Tab. The payroll reports use the date ranges specified in your

payroll filter selections, but includes all non-archived planters that have data within

that date range.

· The Payroll Detail report has an option to email individual planters their payroll

numbers. Email addresses must be entered for each planter you with to email to.
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10 Plant Wizard on Mobile Devices

Plant Wizard is available as version 2018.1 on older iPads and as version 2020 on newer

devices and Android tablets/phones. There are some navigational differences between the

2 versions, but the functionality is the same.

Plant Wizard can be used on a mobile device to track, view, and record the following items

(some items are view-only):

· Site details

· Pre and post plant notes

· Planting plots

· Seedling details

· Shipments of seedlings to the project (recorded on SSMS)

· Deliveries of seedlings to the site

· Planter tallies and work

· Planting prescriptions

· Planted numbers

· Weather and soil conditions

** Note: Plant Wizard on mobile devices will sync data with SSMS to update and /or

share data with another user via an Internet connection.

To install Plant Wizard onto your mobile device, follow the installation instructions found

within "Mobile Device Installation and Upgrading".

10.1 Syncing

All data is transferred to and from the mobile device via syncing with SSMS using an

Internet connection (Wi-Fi, cellular network).

To get new projects - PW 2018.1

· Choose the Download a Project button at the bottom of the screen. The "Select a

Project to Download" window shows you which projects are on the SSMS server

for download. 
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· Click on a project to download it. The projects available for you to download

include all the projects within any SSMS accounts you have access to, plus any

projects for which you are a contributor or are the designated payroll contractor.

To get new projects - PW 2020

· Choose the Menu button in the top left corner and choose "Download Project"

from the list . The "Download Projects" window shows you which projects are on

the SSMS server for download. 

· Click on a project to download it. The projects available for you to download

include all the projects within any SSMS accounts you have access to, plus any

projects for which you are a contributor or are the designated payroll contractor.

· There is an option to Show/Hide Archived projects, however, archived projects

cannot be downloaded to the device.

To improve mobile device performance, only load the projects you need.

Any new data collected on the mobile device will be transferred to SSMS when you sync,

and any new data that exists on the server for that project will be downloaded to the

mobile device.

Choose the Sync button (or the "Sync" option under the Menu button in PW 2020) when

you want to send your changes and receive changes to the selected project on your mobile

device.

10.2 Navigation

From the first screen in PW 2018.1, you can access Settings and Projects:

· Login - select the login name (or the "Not Logged In" message) in the upper left

corner to change or enter a username and select an SSMS server to sync with.

· Initials - select the Initials to enter user initials (to be used when entering Plots,

Tallies, and Site Deliveries to help determine where data originated from).

· Settings - select the Settings button change the seedling label, the site label, the

site sort order, customization, plot GPS location data collection, and enter or sort

any quick text you wish to have available anywhere notes are recorded.

· Projects:

· Select a Project, or use the Download a Project button to download a different

project. 
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· The Download a Project button talks to the SSMS server and allows you to

download other projects that you permissions on.

· The Sync button will sync all of the listed projects data with the SSMS server.

· After selecting a project, there is also a project-specific Sync button that syncs

only the data related to the project selected.

In PW 2020, these options can be found using the Menu button:

· The header shows the regional server you are syncing with (North America or

Australia), the version and build #, the initials being used and the current login.

· Projects - select a project to view, filter to find a project, delete a project, or

show/hide archived projects.

· Download Project - allows users to select projects from the server to download

· Sync - to send your changes and receive changes on your mobile device.

· Settings - set initials, change the seedling label, the site label, the site sort order,

customization, plot GPS location data collection, and enter or sort any quick text

you wish to have available anywhere notes are recorded.

· Change Login - login as a different user.

· Log Out - log out of PW.

· Help - a device-specific help guide is available.

Selecting a project will take you to the Projects Screen. Use the buttons along the bottom

to access:

· Details - Project details including Name, Year/Season, Contact, Plot Multiplier, Site

Count, Sites Completed, Email, Phone, etc. There is also a summary section showing

you the project status and compares total trees and densities from within the

program. You can edit the plot multiplier using the Set Plot Multiplier button at

the bottom, or sync the selected project only using the Sync button.

· Sites - listed by active, planned, and done, accesses Details, Plots, Wx/Soil

Conditions (Wx/Soil), Prescriptions, Deliveries, Planted, Tallies, and Balance

· Payroll - a list of planters with their contact information, ability to select favorites,

view, edit, and add tallies and planter work by date

· Seedlings - seedling list and details associated with the selected project, and a list

of seedling allocations

· Planter Work - view, edit, and create planter work records
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· Shipments - view a list of seedling shipments to (and from) the project created on

SSMS

· Balance - shows the balance of shipped, planted, and delivered trees

After selecting a site, you can access:

· Details - site details including PU Name, Block Name, CP Name, Planted status,

Priority, Area, Elevations, Dates, Densities, and a summary of the PU status. Users can

specify which site details they wish to see at the top of the screen, by selecting the

Site Properties button (on PW 2018.1) or the Info button (on PW 2020) and using

the Reorder Mode or Sort. The top 15 properties will be displayed. Enter Site Notes

(or Notes) from the  Details Screen.

· Plots - view, edit, create plots with associated regen (species composition) and plot

errors, filter plots, and view plot summary

· Wx/Soil - view, edit, record weather and soil conditions by date/time

· Prescriptions - edit and create species prescriptions, and view allocated and planted

numbers

· Deliveries - view, edit, create seedling deliveries to the site

· Planted - view, edit, add daily planting records by seedling ID, add post-plant notes

· Tallies - view, edit, create planters' seedling bagups by seedling ID and date, view

production summary

· Balance - shows the balance of Delivered versus Tallied by initials and date

General navigation:

· Use the Add New button to add new records.

· Use the Change Site button in the top right of any site screen, to quickly switch to

another site without having to go back to the Projects Screen.

You can delete the following records by swiping to the left and using the Delete button on

Plant Wizard 2018.1, or by activating the Delete icon on Plant Wizard 2020 (or newer) and

use the Delete button to the right of the record you wish to delete:

· Sites (only sites that don't exist on the server can be deleted)

· Planter Work
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· Plots

· Plot Regen

· Plot Errors

· Deliveries

· Tallies

· Planted

· Conditions

· Notes

· Prescriptions

You can delete individual projects from the mobile device by swiping to the left or

activating the Delete icon and using the Delete button. This does not delete the project

from the server.

If you delete the Plant Wizard app from the mobile device, any unsynced data will be lost.

10.3 Plots

Plot Collection

1. Select 'Plots' from the Sites Screen.

2. Select the Add New Plot button at the bottom.

3. Fill in the appropriate fields for your plot:

· Name – Plot name will fill in automatically by auto incrementing the last plot

name (if there are any), can be manually changed

· Initials (Init.) - Initial of data collector will fill in automatically based on the

initials from the Settings Screen, can be manually changed

· Plot Type - Audit, Check, Survival, or a custom plot type name

· Trees Planted (P) – Number of trees planted in the plot

· Plantable Spots (PS) – Plantable spots in the plot

· Excess Trees (E) – Number of excess trees planted in the plot. Hidden if using

Potlatch customization.

· Satisfactory Planted (S) – Number of satisfactory planted trees in the plot
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· Unsatisfactory Planted (U) – Number of unsatisfactory trees planted in the plot

· Non-Plantable Spots (NP) – Spots taken up by non-plantable area (this

number is added to trees planted to determine planting density)

· Dropped Trees (Drop) - Any trees noted as dropped in between or within

plots

· Penalty (Pen.) - Any fines associated with the plot or planting unit. Hidden if

using Potlatch customization.

· Latitude / Longitude - Coordinates for this plot, can use Get From GPS

button if GPS is available. This data may be automatically collected if

"Automatically set GPS on new plots" was selected in the project settings.

· Comments – Plot comments

3. If you are recording naturals at the Plot Regen level, click on the Add New Regen

button to record well spaced planted and naturals, as well as total planted and

naturals by species to get a species composition.

4. Click on the Add New Error button to record planting errors by species

(optional) and error code (summarized on the Paycert Report).

Plot Calculations

On the Plots Screen the handheld calculates the following values dependent on the type

of plots you are viewing and/or the filter you are using:

· Qual - Satisfactorily planted trees divided by plantable spots

· Ex - # Excess/Trees Planted

· Sat - Satisfactorily planted trees divided by planted trees

· Plant - Planted trees divided by plantable spots

· Spp - Uses the Total Planted numbers from the regen records to display species

mix %

· At the bottom of every column is a total, density and CI-90 (90% confidence

interval) calculation

Plot Filter

There is a Set Plot Filter button in the bottom left allowing users to filter plots based on

plot type, initials, and/or date. Selecting one of these plot filters will re-calculate the plot
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calculations. The filter button will be highlighted in yellow to indicate that it is being

used and will show you how many plots are being included.

10.4 Australia Plots

The Plots Screen allows you to add new plots (Add New Plot button), edit plots (click on

a row), and delete plots (swipe to the left and choose "Delete", or select the Delete icon

and use the Delete button). Density, Quality, Target Stocking, Species Mix, Fertilizer Quality

and To Be Fertilized are calculated across the top and change based on any plot filters you

may have set.

When you add a new plot, or edit an existing one, you will be accessing the Tree Screen.

Here you can add planted trees (or non-plantable spots) and natural trees. You can track

GPS coordinates and comments as well. The bottom of the screen summarizes your tree

entries.

For each tree, you can specify the species, above ground, below ground, and fertilizer

quality (and ashbed versus non ashbed).  

The Plots Screen has a Filter button at the bottom to allow selection of individual plots.

The Filter button indicates how many plots are filtered out. The plot calculations change

on-the-fly when you filter plots.

10.5 Prescriptions

To collect planting prescription data in the field:

1. Choose the Add New Prescription button on the Prescriptions Screen, then select

a species and the Pref species ratio. You may also specify stock type and Min/Max

species ratios to help with suitability and automatic allocation. Select a fertilizer

code if you plan to fertilize that tree species and specify a %.

2. The Prescriptions Screen also contains a summary of seedlings required, allocated,

planted, and the suitability of individual seedlings (P = Preferred, A = Acceptable,

U= Unsuitable), as well as the area (on larger devices) and planting status.

10.6 Deliveries

The mobile device will track signouts to sites:

1. Choose a site, then the Deliveries button 

2. Select the Add New Site Delivery button 

3. A list of seedlings that have been associated with the project will appear on the

handheld with an indication of which ones are preferred, acceptable, and
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unacceptable. There are also symbols indicating which seedlings have already been

delivered, allocated, planted, and/or tallied on that site.

4. Enter the number of boxes or seedlings you are signing out.

5. The other fields are filled in automatically but can be changed manually if needed.

Notes can be added if desired.

The Add New Site Return button simply adds a negative delivery record and is used to

send any unused trees back at the end of the day.

10.7 Planting Numbers

The number of seedlings planted of each seedling item in each site is recorded on the

Planted Screen. Choose the Add New Planted button at the bottom, then select a

seedling item from the list and enter in the amount planted. Seedlings have indicators

showing which ones are preferred, acceptable, unacceptable, allocated, delivered, planted,

and tallied. You can specify whether or not the trees were fertilized by editing the Fert.

field.  

10.8 Planter Tallies / Work

Plant Wizard tracks individual planter tallies and other work types. Tallies can be entered on

the handheld then synced to SSMS, or entered directly into the desktop. Once on the

desktop, they can be used for payroll reports.

Planters must be created on the desktop prior to syncing to SSMS and the mobile device.

Planters can enter each bagup, or the foreman can enter daily totals as a summary.

Planter work items other than tree tallies can also be tracked on the mobile device. Work is

tracked at the project level and/or site level, whereas tallies are tracked by site.

A list of favorite planters can be created on the mobile devices under the Payroll Screen to

aid in quick data entry. Indicate a favorite planter by selecting the star symbol beside the

planter name. Planter lists on the Tallies and Work Screens will show the favorite planters

listed at the top and alphabetically sorted.

The Payroll Screen can be used to quickly add tallies and work for each day without

having to go to the Work or Tallies Screens.

10.9 Seedling Balance

The Balance Screen at the Project level is used to view the balance between seedlings

shipped to the project, planted, and delivered to the project's sites.
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The Balance Screen at the Site level is used to view the balance between seedlings

delivered to the site and seedlings tallied. The balance is shown by initials and date.
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11 Reports

Some of the reports will prompt the user for additional information before running (date

range, blocks, sites, plot types, etc.). If you select more than one site to run a report on, the

extra sites will be added to the existing report and calculations will include all sites. If you

wish to run individual reports for multiple sites at once, choose "Run Batch", select the sites

and choose whether you want one report per block or one report per site. Each block or site

report will be exported as an Excel sheet.

With the exception of the Payroll Detail, Plot Analysis, and the Export reports, all the reports

in Plant Wizard can be customized by the user in MS Excel.  

The report files are specifically named so that Plant Wizard can identify them as Plant

Wizard reports and provide the correct data for them. The file name contains two parts

separated by an underscore (ie. POSTPLANT_Seedlings Planted.xls).  

· The first part of the example file name (POSTPLANT) identifies the report type so

when it runs, Plant Wizard will send out the relevant information.  

· The second part of the name (Seedlings Planted) is displayed as the report name in

the Reports Tab.

There are 2 report directories:

· CustomReports – contains any reports specific to your operation. Any reports that

you have edited can be placed here to show under the ‘Custom Reports’ section.

· ReportsTemp_Volatile – reports within this folder are replaced when Plant Wizard is

opened and after upgrade to ensure users have the latest version.

To determine which section a report will appear under (and the description of it), navigate

to the appropriate report folder and edit the .txt file associated with the report. On the first

line enter the section name you wish the report to appear in on the Reports Tab and on

the second line enter a report description.

If you wish to customize any of the reports, use "Clone Report", give it a new name, and

edit it from the CustomReports folder.

Most Plant Wizard tabs also have the option to send data to MS Excel where data can be

sorted, manipulated, and printed.

11.1 Customizing Reports

Customize a Report

Any reports that show the Clone Report button when selected, can be customized.
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1. In the Reports Tab, select the report you wish to customize, and click the Clone

Report button.

2. After giving the report a name and an optional description, the report will open

and you can edit it.

3. If you need data in the report in order to edit it, run the original report from

within Plant Wizard, open your custom report (using Windows Explorer), and copy

the resulting "Data Tables" sheet from the original to your custom report. The

Data Tables contain the field names and ranges that you may need for

customizing your report.

4. Make the necessary edits to your custom report and delete the Data Tables sheet

when you are happy with it.

5. This custom report will appear in the Custom Reports section in Plant Wizard.

Rules for Single Fields

To ensure good results, there are several rules that need to be followed when editing a

template.

· They can be placed anywhere on the report and are referenced by a specific

formula.  

· They are named to be easily identified.

· They can be formatted in any way.

· Their cells and resulting values can be referenced to other worksheets for

summarizing, etc.

Rules for Repeating Rows of Data

Rows of data are treated differently when the number of rows is variable depending on

the number of records in the database (i.e. number of plots relative to a site - the site

name is a single field but the plot data is a variable number of rows for each site).

· These rows of data will exist in a specified range within the Data Tables

worksheet.

· To reference a range of data from the Data Tables worksheet, select a row of cells

on your report and type in 'Fill_rangename' in the formula editor.
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· For individual cell references, specify the column heading names from the Data

Tables (ex. SiteLabel, SeedlingLabel, Nursery, etc).

· A range can only be used once for the entire workbook.  If there is more than one

instance of it, only the first range will get data.

· New rows are inserted as needed when the report is run.

· All data and ranges below a range are moved downward to accommodate the

rows needed when the report is run.

· To change the defined range in Excel use the Name Manager. 

** Note: This is the most complex area of the report and should be edited very

carefully.  Failure to follow the rules associated with ranges can cause the entire

report to fail.

11.2 Silviculture and Inventory Labels

The silviculture and inventory labels that are produced for some of the reports are based on

the plot types selected when the reports are run.
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Silviculture Label

· species composition is determined using the plot regen well-spaced planted

(WSP) + well-spaced natural (WSN) numbers by species

· age and height come directly from the Stand Age and Stand Height fields at the

site level

· site index and source come from the Site Index and Site Index Src fields at the site

level

· well spaced density is determined using the plot regen well-spaced planted

(WSP) and well-spaced natural (WSN) numbers combined, capping each plot at

the maximum of the WS target density1 / plot multiplier

· 2-digit survey year reflects the project year

1 - uses "Target Density" if "WS Target Density" is blank

Inventory Label

· species composition is determined using the plot regen total planted (TP) + total

naturals (TN) numbers by species to the nearest 10%

· age and height come directly from the Stand Age and Stand Height fields at the

site level

· site index and source come from the Site Index and Site Index Src fields at the site

level

· crown closure comes from Crown Closure at the site level

· total density is determined using the plot regen total planted (TP) and total

naturals (TN) numbers combined

· 2-digit survey year reflects the project year
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12 Appendix A: "How To" Guide

Click on the links below for further information on each of the topics.

Managing Plant Wizard Licenses:

· Installing PW

· Upgrading PW

· Registering PW

· Setting up Payroll

Preferences:

· Plot multiplier

· Recording Naturals at the Plot or Plot Regen level

· Setup custom plot type names

· Seed, seedling and site labels

· Metric versus imperial

· Auto populate "Initials" fields

· Setting a minimum planting quality %

Entering Project Data:

· Importing project data from Excel

· Importing project data SSMS

· Manually entering project data

Managing Sowing:

· Setting up sow plans (projects)

· Importing or downloading seed

Managing Seedlings:

· Importing seedlings from SSMS
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· Comparing seedling balances

· Tracking seedling deliveries

· Tracking seedling deliveries (signouts) on mobile device

Tree Planting:

· Recording planter tallies on the desktop and on the mobile device

· Recording planted trees (reconciled)

· Recording planting plots

Financial Data:

· Contract prices

· Planter prices

· Managing payroll data

Exchanging Data:

· Exchanging data with SSMS

o Importing seedlings

· Exchanging data with Excel

o Exporting seedlings

o Importing projects

o Exporting projects

o Exporting allocations

· Exchanging data with other PW users

· Exchanging data with mobile devices

o Loading data

· Exchanging data with LRM

Reports:

· Managing reports
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13 Appendix B: Troubleshooting

Startup

Why is Plant Wizard slow to start at times?

Turn off windows automatic proxy setting detection:

1. Click "Start" and "Control Panel".

2. Double-click "Internet Options".

3. Click the Connections tab and click on "LAN Settings".  This will open the Local

Area Network (LAN) settings window.

4. Uncheck "Automatically detect settings".  Click "OK".

5. Restart your computer.

Seedling Allocation

How do I reallocate some of my seedlings without losing all of the
current allocations?

For sites that you want to leave untouched, check the box  called "Locked" on the Site

Tab (or leave them unselected during the auto allocation process).

Payroll

Why can't I see or enter Planters, Tallies, Work, Planter Rates?

Ensure that you have payroll permissions for the projects you are working on.
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14 Appendix C: Technical Support

Help Desk: 

Technical support is available for licensed Plant Wizard users. 

The Help Desk is open Monday to Friday, 8:30 a.m. to 5:00 p.m. PST. We are closed for

Canadian statutory holidays.

We can be reached in the following ways:

Phone:  (250) 703-0451 ext. 300

E-mail:  support@jrpltd.com

Please have the following information available when contacting us:

· Operating system (i.e. Windows version or iOS version)

· Plant Wizard desktop version

· Plant Wizard device version

· Any error messages that may have occurred

Help Manual:

Plant Wizard help manual is available from the Help menu.

Cheat Sheets:

Task oriented help is available in short individual "Cheat Sheets" available online and under

the Help menu.

Help Videos:

Task oriented help is available in short individual videos available online and under the

Help menu.

Sync Logs:

To see previous sync logs, look under the Help menu.

Online Support:

Visit our online support website at https://plantwizard.jrpltd.com/support/.

mailto:support@jrpltd.com
https://plantwizard.jrpltd.com/support/
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